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Introduccion

ASP.NET es una plataforma de desarrollo de Microsoft de las mas extendidas en
la programacion web. Combinado con el entorno de desarrollo por excelencia
de Microsoft, Visual Studio 2010, se pueden crear sofisticadas aplicaciones web

de forma visual y rapida.

En este modulo se ofrece una introduccién al entorno de desarrollo (frame-
work) .NET, una descripcién a grandes rasgos del lenguaje de programacion
C#y, por ultimo, una introduccién a la plataforma de desarrollo ASP.NET 4.0
incluidos los controles ASP.NET AJAX, que es uno de los aspectos diferencia-
dores respecto a otras plataformas de desarrollo.
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Objetivos

Los objetivos de este modulo didactico son los siguientes:

1. Mostrar el uso de tecnologia AJAX en uno de los entornos de desarrollo
mas utilizados hoy en dia: .NET.

2. Conocer qué es ASP.NET y su implementacion AJAX.

3. Familiarizarse con el entorno de desarrollo Visual Studio 2010.

4. Crear sitios web y disefiar paginas ASP.NET interactivas que respondan a
las diferentes acciones de los usuarios.

5. Comprender el ciclo de vida de una pagina ASP.NET entre diferentes tipos

de peticiones.
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1. El1 entorno de desarrollo “.NET Framework”

.NET es un término utilizado por Microsoft para dar nombre a un conjunto
de tecnologias —algunas revolucionarias, otras no tanto- que estan disefiadas
para ayudar a los desarrolladores a crear diferentes tipos de aplicaciones, desde
aplicaciones de escritorio o servicios de Windows hasta aplicaciones web.

El conjunto de tecnologias que forman el entorno de desarrollo' “.NET Fra- En inglés, framework.

mework” son las siguientes:

e Los lenguajes de programacion .NET: entre ellos Visual Basic, C#, F# y

C++.

¢ El Common Language Runtime (CLR): es el motor que ejecuta todos los
programas de .NET y que provee servicios automaticos para estas aplica-

ciones, como la comprobacion de seguridad o la gestion de memoria.

e La biblioteca de clases de .NET: contiene miles de clases, interfaces, es-
tructuras, ... con una funcionalidad predefinida que se pueden utilizar en

las aplicaciones .NET.

e ASP.NET: es el motor que permite ejecutar las aplicaciones web creadas
en .NET.

e Visual Studio: es la herramienta de desarrollo por excelencia de Microsoft.
Permite realizar cualquier tipo de aplicaciéon .NET y su depuracion.

1.1. C# y Visual Basic

Durante este apartado, como se podra ver, utilizaremos el lenguaje C# para
realizar los ejemplos. Este lenguaje se asemeja bastante a Javay a C++. A su vez
C# y Visual Basic son bastante similares; de hecho, casi cualquier bloque de
codigo puede ser traducido de un lenguaje a otro, pero su sintaxis es diferente.

Tanto C# como Visual Basic utilizan la biblioteca de clases de .NAT y son com-
patibles con el CLR.
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1.2. El Common Language Runtime (CLR)

El Common Language Runtime (CLR?) es el motor que soporta todos los len-
guajes .NET. En realidad, soporta el lenguaje intermedio entre el lenguaje na-

tivo y el lenguaje de programacién Microsoft Intermediate Language (MSIL?).
El CLR interpreta este c6digo intermedio y lo transforma en c6digo maquina.

Para entenderlo mejor, el CLR seria el simil en Microsoft de la maquina virtual
en Java.

1.3. La biblioteca de clases de .NET

La biblioteca de clases de .NET es un repositorio gigante de clases que propor-
cionan una funcionalidad predefinida, desde la lectura de un archivo XML
hasta el envio de un correo electronico. Cualquiera de los lenguajes .NET pue-
de utilizar dicha biblioteca de clases.

Ciertas partes de la biblioteca nunca se utilizan en programacién web y solo
se utilizan para realizar aplicaciones de escritorio, mientras que otras estan

concebidas exclusivamente para aplicaciones web.

Como hemos podido ver, la filosofia de Microsoft es proporcionar la infraes-
tructura de las funcionalidades mas comunes para que los desarrolladores solo

tengan que programar cédigo especifico de la aplicacion.

@CLR es la sigla de Common Lan-
guage Runtime.

OMSIL es la abreviatura de Micro-
soft Intermediate Language.
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2. El lenguaje de programacion C#

Antes de empezar a crear una aplicaciéon ASP.NET, el programador debe elegir
el lenguaje de programacién, C# o Visual Basic. La opcién normal si no se ha
programado nunca es Visual Basic por parecerse mas al lenguaje natural; en
cambio si ya se ha programado antes en C, C++ 0 Java, la eleccion suele ser C#.

En este médulo mostraremos las caracteristicas principales de C#, los tipos de
datos, las operaciones, los condicionales o los bucles existentes.

2.1. Caracteristicas y peculiaridades

Las principales caracteristicas que definen C# como uno de los lenguajes mas
potentes y modernos de la actualidad son:

a) Es orientado a objetos. A excepcién de algunos datos simples como los

enteros, flotantes o strings, el resto de las entidades son clases predefinidas en
las bibliotecas de clases de .NET.

b) Es un lenguaje compilado. Se necesita un compilador especifico que tra-
duzca el lenguaje C# a cédigo MSIL, que, como sabemos, es el que interpreta

el CLR.

c) Dispone de la biblioteca de clases .NET. Desde C# tenemos acceso a toda
la biblioteca de clases de .NET, que implementa multitud de funcionalidades.

d) Dispone de garbage collector. La destruccion y liberacién de memoria se
gestiona de forma automatica totalmente transparente al desarrollador.

Por otro lado, alguna de las peculiaridades que diferencian a C# de otros len-
guajes de programaciéon son:

a) Diferenciacion entre maytusculas y mintsculas. En C# no es lo mismo
definir una variable llamada prueba a otra variable Prueba. Algunos lenguajes

de programacién, como por ejemplo Visual Basic, no hacen esta distincion.

b) Comentarios. Los comentarios son textos descriptivos que son ignorados
por el compilador. C# dispone de dos tipos de comentarios basicos:

e Fl comentario de una linea:

// Comentario de una linea

e El comentario de multiples lineas:
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/* Comentario de multiples

lineas */

¢) Terminacion de sentencia. Toda sentencia en C# debe terminar con el
caracter “; ”. Es importante recordar que una sentencia puede componerse de
mas de una linea, como podemos ver a continuacion:

// Sentencia en una linea
valor = valorl + valor2 + valor3;

// Sentencia en varias lineas
valor = valorl + valor2 +

valor3;

d) Bloques. Todo conjunto de sentencias debe empezar con el caracter “{”
y terminar por el cardcter “}”. Estos conjuntos pueden ser funciones, clases,
bucles, etc.

//Conjunto de sentencias

2.2. Variables y tipos de datos

Al igual que todos los lenguajes de programacion en C#, se pueden mantener
datos en memoria utilizando variables. Las variables pueden almacenar ntime-
ros, texto, fechas, horas e incluso pueden guardar direcciones a otros objetos.
Cuando se declara una variable se le asigna un nombre y se especifica el tipo
de datos al que pertenece.

//Declaracidén de un entero llamado cdédigo
int cédigo;
//Declaracién de un string llamado nombre

string nombre;

En la tabla siguiente podemos ver los tipos de datos disponibles en C#:

Figura 1. Tipos de datos en C#

Nombre del tipo Descripcion
byte Entero de 0 a 255
short Entero de -32,768 a 32,767
int Entero de —-2,147,483,648 a 2,147,483,647
long Entero de -9.2e18 a2 9.2e18
float Numero de punto flotante de —3.4e38 a 3.4e38
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Nombre del tipo Descripcion
double Numero de punto flotante de —1.8e308 a 1.8e308
decimal Numero fraccionario de 128-bit
char Caracter Unicode
string Conjunto de caracteres Unicode
bool Valor de true o false
DateTime Representacion de fechas

2.2.1. Asignaciones e inicializaciones

Cuando se declara una variable, se le pueden asignar valores siempre y cuando

estos valores sean del tipo correcto.

//Declaracidén de variables
int cédigo;

string nombre;
//Asignacién de valores
codigo = 10;

nombre = "UOC"

También se puede asignar un valor en el mismo momento en que se declara

la variable.

int codigo = 10;

string nombre = "UOC"

2.2.2. Arrays

Los arrays permiten al desarrollador almacenar una serie de valores del mismo
tipo. Puede accederse a cada valor mediante la posicién que ocupa en el array,

teniendo en cuenta que el primer valor de un array tiene indice 0.

//Creacidén de un array con cuatro strings
string[] stringArray = new string[4];
//Creacidén e inicializacién de un array con cuatro strings

string[] stringArray = {"1","2","3","4"};
Para acceder a un elemento, se ha de especificar el indice entre corchetes [].

int[] intArray = {1,2,3,4};

int elemento = intArray[2]; //elemento se inicializa con un 3
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2.2.3. Arraylist

Los arrays en C# no pueden ser redimensionados, es decir, una vez creados no
se pueden cambiar de tamafio. Si se necesita un array dindmico, se puede uti-
lizar una clase de la biblioteca de clases de .NET llamada ArrayList, que ademas
acepta que los elementos de los arrays sean de cualquier tipo.

Utilizacion de la clase ArrayList
A continuacién vemos un ejemplo de utilizacién de la clase ArrayList:

//Creacidén de un objeto ArrayList
ArrayList listaDinamica = new ArrayList();
//Adicidén de diferentes strings a la lista
listaDinamica.Add ("primero") ;
listaDinamica.Add ("segundo") ;
listaDinamica.Add ("tercero");

2.2.4. Enumeraciones

Una enumeracion es un grupo de constantes relacionadas, a cada una de las
cuales se le da un nombre descriptivo. Cada valor de una enumeracion corres-

ponde a un nimero entero prefijado.

//Definicién de una enumeracién llamada TipoUsuario
enum TipoUsuario
{

Admin,

Invitado,

Erroneo

Ahora ya se puede utilizar TipoUsuario como un tipo de datos especial con
solo tres valores.

//Creacién de un nuevo valor de tipo Admin

TipoUsuario usuario = TipoUsuario.Admin;
2.2.5. Operaciones con variables

En C# el desarrollador puede utilizar todos los tipos estdndar de operaciones.
Cuando se trabaja con tipos numéricos, se pueden utilizar los simbolos mate-

maticos que podemos ver en la tabla siguiente:

Figura 2. Operaciones en C#

Operador Descripcion Ejemplo
+ Suma 1 +1=2
- Resta 5-2=3

Multiplicacién 2 *5 =10
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Operador Descripcion Ejemplo
/ Division 5.0 / 2 =2.5
% Resto de la division entera 7%3=1

Para controlar el orden en que se ejecutan, las expresiones pueden agruparse

entre paréntesis.

int numero;

numero = 4 + 2 * 3;
//numero sera 10
numero = (4 + 2) * 3

//numero seré& 18

La divisién en C# puede ser algo confusa. Si se divide un ntimero entero por
otro entero, C# realiza una divisién entera, es decir, se descarta automatica-
mente la parte fraccionaria del resultado. La solucion a este problema es defi-
nir uno de los nameros, o0 ambos, como fraccionarios; por ejemplo, 5 pasaria

a ser 5.0. De esta manera obtendremos un resultado correcto.

En C# la operacion adicion + se puede utilizar también para concatenar strings.

//Concatenacién de tres strings

nombreCompleto = nombre + " " + apellidos;

En C# cuando la operacion y la asignacién se hacen sobre la misma variable

se pueden utilizar los operadores de la siguiente forma:

//Afiadir 10 a valor. Es lo mismo que valor = valor + 10
valor += 10
//Multiplicar valor por 3. Es lo mismo que valor = valor * 3

valor *= 3

2.2.6. Conversiones de tipo

Convertir informacioén de un tipo de dato a otro es algo bastante comun en
el mundo de la programacion. Las conversiones de datos pueden ser de dos
tipos: implicitas o explicitas; por ejemplo, la conversiéon de un tipo int a un
long es implicita, porque no implica pérdida de informacion; sin embargo, la
conversioén de un tipo long a un int es explicita debido a que en esta puede
haber perdida de informacién.

Para las conversiones implicitas no se necesita ningan codigo especial:

int valorPequeno;

long valorGrande;

//La conversidén siempre se puede realizar porque un long puede contener a un int
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valorGrande = valorPequeno;

En cambio, en las conversiones explicitas, es necesario indicar el tipo entre

paréntesis a la izquierda de la variable.

int valorGrande = 1000;

short valorPequeno;

//S1i el valorGrande supera la capacidad de un short habrd pérdida de

valorPequeno = (short)valorGrande;

2.2.7. El tipo String

La clase string de la biblioteca de clases de .NET nos permite manipular de

multiples maneras una cadena de texto.

Ejemplo

string mistring = "Esto es un string de ejemplo ";

mistring = mistring.Trim(); //"Esto es un string de ejemplo";
mistring = mistring.Substring(0,4); //"Esto";

mistring = mistring.ToUpper () ; //"ESTO";

mistring = mistring.Replace ("O","A"); //"ESTA";

int longitude = mistring.Length; /= 4;

En los ejemplos anteriores cada método de la clase String genera un nuevo string que
es asignado a la variable mistring. Todas estas sentencias se pueden realizar en una sola

linea:

mistring = mistring.Trim() .Substring(0,4) .Replace("O","A");

En la tabla siguiente vemos alguno de los métodos y propiedades mas impor-

tantes de la clase String:

Figura 3. Funciones y propiedades de la clase String

Miembro

Descripcion

Lenght

Retorna el nimero de caracteres del string.

ToUpper () y ToLower ()

Retorna un string con todos los caracteres del string original
en mayuscula o mindscula.

Trim() Retorna un string sin los espacios del string original.

Insert () Inserta otro string en el string original en la posicion indica-
da.

Remove () Elimina un nimero determinado de caracteres desde una po-
sicién determinada.

Replace () Reemplaza un substring del string original con otro string.

Substring () Devuelve una porcién del string de una longitud determina-

da.

StartsWith () y EndsWith ()

Determina si un string comienza o acaba en un determinado
substring.

informacién.
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Miembro Descripcion

Split () Devuelve un array con todos los substrings resultantes de
seccionar el string por un caracter determinado.

Join () Fusiona un array de strings en un string Gnico.

2.2.8. Los tipos DateTime y TimeSpan

Los tipos de datos DateTime y TimeSpan disponen de métodos y propiedades
para manipular fechas y tiempos respectivamente.

Ejemplos
Podemos ver a continuacién un ejemplo de manipulacién de fechas con DateTime:

DateTime miFecha = DateTime.Now;
miFecha = miFecha.AddDays (100) ;
string dateString = miFecha.Year.ToString();

En el ejemplo siguiente vemos coémo buscar la diferencia en minutos entre dos fechas:

DateTime miFechal = DateTime.Now;

DateTime miFecha2 = DateTime.Now.AddHours (3000);
TimeSpan diferencia;

diferencia = miFecha2.Substract (miFechal) ;
double numeroMinutos;

numeroMinutos = diferencia.TotalMinutes;

Las clases DateTime y TimeSpan también soporta los operadores aritméticos
+y -, incluso entre un objeto DateTime y otro TimeSpan.

Ejemplo

DateTime miFechal = DateTime.Now;
TimeSpan intervalo = TimeSpan.FromHours (3000) ;
DateTime miFecha2 = miFechal + interval;

A continuacién podemos ver dos tablas con algunos métodos y propiedades

de las clases DateTime y TimeSpan:

Figura 4. Funciones y propiedades de la clase DateTime

Miembro Descripcion
Now Devuelve la fecha y hora actual.
Today Devuelve la fecha actual.
Year, Date, Month, Hour, Minute, Secondy Millisecond Devuelve una parte de un DateTime
DayOfWeek Devuelve el dia de la semana de un DateTime.
Add () y Subtract () Afade o resta un TimeSpan de un DateTime.
AddYears (), AddMonths (), AddDays (), AddHours (), AddMi - | Aflade una porcién de tiempo a un DateTime.
nutes (), AddSeconds (), AddMilliseconds ()
DaysInMonth () Devuelve el nimero de dia de un determinado mes.




CC-BY-SA » PID_00194034 16 Introduccién a ASP.NET

Figura 5. Funciones y propiedades de la clase TimeSpan

Miembro Descripcion
Days, Hours, Minutes, Seconds, Milliseconds Devuelve una parte de un TimeSpan
TotalDays, TotalHours, TotalMinutes, TotalSeconds, Devuelve el total de dias, horas,... que tiene un TimeSpan.
TotalMilliseconds
Add () y Subtract () Afiade o resta un TimeSpan a otro TimeSpan.
FromDays (), FromHours (), FromMinutes (), FromSe- Construye un TimeSpan a partir de dias, horas, etc.
conds (), FromMilliseconds ()

2.3. Condicionales légicos

En muchas ocasiones se necesita una condicién légica para decidir qué accién
tomar sobre la base de una informacién determinada. Una condicién légica
puede ser evaluada como verdadera o falsa y en funcién de esto, ejecutar un
bloque de cédigo u otro. Para crear una condicién podemos utilizar cualquier
combinacién de variables o literales con los operadores 16gicos que vemos en

la siguiente tabla:

Figura 6. Condicionales en C#

Operador Descripcion

== Igual a

1= Diferente de

< Menor que

> Mayor que

<= Menor o igual a
>= Mayor o igual a
&& AND légico

Il OR légico

La sentencia if es la pieza clave de la logica condicional en la programacion.
A continuacién vemos un ejemplo donde se evaltia una condicion y se ejecuta

un bloque de c6digo u otro:
if (numero > 10)
{
//Bloque A

else

//Bloque B
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C# también pone a nuestra disposicion la sentencia switch, que nos sirve
para evaluar una variable para varios posibles valores. La tnica limitaciéon de
la sentencia switch es que la variable solo puede ser de los tipos int, bool,

char, string o el valor de una enumeracion.

switch (numero)
{
case 1:
//Bloque A
break;
case 1:
//Bloque B
break;
default:
//Bloque C

break;

Vemos que en cada bloque de c6digo debemos indicar la palabra break; si no

lo hiciéramos, se seguiria ejecutando el cédigo de forma secuencial.

2.4. Bucles

En C#, al igual que en la mayoria de lenguajes, existen tres tipos de bucles para
ejecutar bloques de cédigo de forma iterativa: for, foreach y while;

El bucle for permite al programador poder repetir un bloque de cédigo un
numero predeterminado de veces. Para crear un for es necesario especificar
un valor inicial, un valor final y el incremento de cada iteracion.

for (int i = 0; 1 < 10; i++)
{

//Bloque de cddigo

El bucle foreach nos permite recorrer los elementos de un conjunto de da-
tos. Con un foreach no es necesario crear una variable para el contador y
ademas es especialmente util para recorrer listas, arrays o colecciones de datos

en general.

string[] stringArray = {"uno","dos","tres"};
foreach (string element in stringArray)
{

System.Diagnostigs.Debug.Write (element + " ");
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Finalmente, C# dispone del bucle while que sirve para comprobar una con-
dicion especifica antes o después de cada iteracién de un bloque de cédigo.
Cuando esta condicion es falsa, se sale del bucle; por el contrario, mientras sea
verdadera se van realizando iteraciones en el bloque de cédigo.

int i = 0;

while (i < 10)

Otra forma de implementar el bucle while es poniendo la condicion al final
del bloque de c6digo; de esta forma nos aseguramos de que el codigo se ejecuta

por lo menos una vez.

} while (i < 10);

2.5. Métodos

Los métodos en C# son el bloque de c6digo més basico que podemos utilizar
para organizar nuestro c6digo. Cuando se declara un método, la primera parte
de la declaracién indica el tipo de datos del valor de retorno y la segunda el
nombre de método.

//Método que no devuelve ningun valor
void MetodoQueNoDevuelveValor ()
{

//Cbédigo

//Método que retorna un entero
int MetodoQueRetornaUnInt ()

{

return 10;

Los métodos pueden aceptar parametros. Los parametros se declaran de forma

muy similar a la declaracion de variables.

int sumaNumeros (int numerol, int numero?2)

{

return numerol + numero2;
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//Llamada al método

int resultado = sumaNumeros (10,10) ;

Cabe destacar que en la declaracion de los parametros podemos darles un valor
por defecto.

private string NombreUsuario (int ID, bool esAdmin = false)
{

//Cbédigo

Una caracteristica propia de C# relacionado con los métodos es la sobrecarga,

es decir, podemos crear mas de un método con el mismo nombre pero con
diferentes parametros.

public decimal GetPrecioProducto (int ID)
{
//Cdédigo
}
public decimal GetPrecioProducto (string nombre)
{
//Cédigo

2.6. Clases y objetos

C#, como hemos dicho, es un lenguaje de programacion orientado a objetos.
Una clase es la definicién del c6digo de un objeto y la creacién de una clase
en C# se realiza de la siguiente forma:

public class MiClase
{

//Cbébdigo de la clase

En una clase podemos definir variables que sean variables miembro o propie-
dades de la clase. Estas variables pueden tener diferentes niveles de acceso, que
se especifican en la declaracion de la variable.

public class Producto
{
private string nombre ;

private decimal precio;
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En la siguiente tabla podemos ver los diferentes niveles de acceso disponibles
en C#:

Figura 7. Niveles de acceso en C#

Nivel de acceso Accesibilidad

public Accesible por cualquier clase

private Solo accesible por miembros de la propia clase

internal Accesible por cualquier clase del ensamblado actual

protected Accesible por miembros de la propia clase o por clases que hereden de esta

Para una clase también podemos definir una serie de métodos que llamaremos
métodos miembro, y al igual que una variable miembro, deben tener el nivel de
acceso definido en la declaracion.

public class Producto
{
private string nombre ;

private decimal precio;

public decimal GetPrecio ()
{

return this.precio;

Un método especial que todas las clases deben tener es el constructor de clase,
que es el encargado de inicializar los parametros de la clase. Puede haber uno o
mas constructores, cuyo nombre serd el mismo de la clase a la que pertenecen,
pero que se diferenciardn en el conjunto de los pardmetros que se le pase a
cada uno.

public class Producto
{
private string nombre ;

private decimal precio;
public void Producto (int precioInicio)
{

this.precio = preciolnicio;

public decimal GetPrecio()

return this.precio;



CC-BY-SA » PID_00194034 21

Introduccion a ASP.NET

Una vez hemos construido una clase como la anterior, podemos crear tantas
instancias de ella como queramos; cada una de ellas serd lo que se denomina
un objeto.

Product productoVenta = new Product (50);

int precio = productoVenta.GetPrecio();
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3. Introduccion a las herramientas de desarrollo

Las aplicaciones ASP.NET pueden crearse con un simple editor de textos, in-
troduciendo todo el cédigo -tanto el disefio de la interfaz (XHTML/CSS/Javas-
cript) como la légica (c6digo C#)- en moédulos .aspx, que serian compilados
dindmicamente por el motor de ASP.NET en el momento de recibir las solici-
tudes.

Esta, sin embargo, es una solucién viable tnicamente para proyectos muy pe-
quefos, ya que es dificil mantener un disefio de interfaces a partir de la escri-
tura manual de los atributos de todos los elementos, y de una mezcla de codi-

gos en diferentes lenguajes en un mismo archivo.

Dependiendo de cudles sean nuestros objetivos y necesidades, tenemos a nues-
tra disposicion diferentes herramientas utiles para el desarrollo de aplicaciones
basadas en ASP.NET. El punto de partida seria Visual Web Developer Express.
Se trata de una herramienta gratuita, descargable directamente desde el sitio
web de Microsoft y con los elementos necesarios para construir aplicaciones
bésicas y de nivel medio, con limitaciones sobre todo a la hora de trabajar con

servidores de bases de datos.

Mas sofisticados son los entornos de trabajo que ofrecen las diferentes versio-
nes de Visual Studio 2010, que ademas de aplicaciones ASP.NET, tienen capa-
cidad para desarrollar muchos tipos de proyectos: aplicaciones para Windows,
para dispositivos méviles, para Office, etc.

3.1. Visual Studio

Desde hace afios, la herramienta de desarrollo por excelencia para plataformas
Windows se denomina Microsoft Visual Studio, un producto que retine com-
piladores para diferentes lenguajes, editores de c6digo con avanzadas caracte-
risticas de ayuda a la codificacion, disefiadores de interfaces de usuario, depu-
racion integrada, gestion de proyectos complejos, edicién de bases de datos

tanto locales como remotas, etc.

La tltima version de Visual Studio se apellida 2010 (figura 8), y va unida a
la version 4.0 de la plataforma .NET. A la hora de iniciar un nuevo proyecto,
sin embargo, es posible elegir la version de la plataforma .NET sobre la que se
ejecutara: 2.0, 3.0, 3.5 0 4.0. Esto permite usar una tinica herramienta para el

desarrollo de aplicaciones sobre distintas versiones de la plataforma.



CC-BY-SA » PID_00194034 23

Introduccién a ASP.NET

Hay disponibles multiples ediciones de Visual Studio dirigidas tanto a usua-
rios individuales (Standard y Professional) como a grupos de trabajos (Team
System). En lo relativo al desarrollo de aplicaciones web basadas en ASP.NET,
sus capacidades son basicamente las mismas.

Figura 8. Visual Studio 2010
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A diferencia de Visual Studio, Visual Web Developer es una herramienta es-
pecifica para el desarrollo de aplicaciones web con ASP.NET que no cuenta
con opciones para la construccion de otros tipos de proyectos. Por lo tanto,
si necesitamos disefiar soluciones complejas en las que la aplicaciéon web sea
solamente una de las partes, Visual Web Developer nos resultaréd insuficiente
y tendremos que recurrir a alguna de las ediciones de Visual Studio. En lo re-

ferente a nuestro curso, tendremos mas que suficiente con esta herramienta.

Visual Web Developer permite usar como lenguaje de implementacién tanto
Visual Basic como C#, pero no permite seleccionar la version de la platafor-
ma .NET sobre la que se ejecutard el proyecto, asumiendo siempre que sera
la 4.0.

Otra diferencia respecto a Visual Studio es que Visual Web Developer solamen-
te permite trabajar con bases de datos locales, no remotas. Tampoco existe la
posibilidad de efectuar depuracién remota con la aplicaciéon ejecutandose en

un equipo que no sea el de desarrollo.

Por lo demads, Visual Web Developer incorpora el mismo disefiador de paginas
ASP.NET que Visual Studio, el mismo editor de c6digo, los mismos componen-
tes y también los mismos servicios fundamentales: los de la plataforma .NET
4.0.
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El gestor de proyectos es practicamente idéntico al de Visual Studio, al igual
que el explorador de bases de datos, el explorador de objetos y muchas otras

utilidades incluidas en el entorno.

Figura 9. Formulario de creacién con las diferentes plantillas disponibles

Nuevo sitio web

plork a2 ecionte Ordenar por: | Predeterminado v | o]

Plantillas instaladas
B siio web asp.neT visual C# Tipo: Visual C#

Visual Basic i=ch ’ Un sitio web ASP.NET.
%ﬁ Sitio web ASP.NET (Razor) visual Ci#
@g Sitio web vacio de ASP.NET visual Ci#
L‘?/’ Sitio web de entidades de datos dindmicos de ASP.NET Visual C#
L(?/’ Sitio web de Ling to SQL de datos dinémicos de ASP.NET visual C#
oh g Servido Wer visual C#
Ubicacién web: | sistema de archivos | | C:\Documents and Settings\Otrosiis Studio v| [ exemier... |

3.1.1. Instalacion de Visual Web Developer

Para que podamos descubrir las capacidades de Visual Web Developer primero
es necesaria la instalacion de la herramienta. Para ello accederemos a la pagina
de Microsoft Visual Web Developer 2010 Express.

Una vez en la pagina, haremos clic sobre el botén Install now. Esto lanzara el
Web Platform Installer, que nos descargard e instalara el producto automati-

camente.

Figura 10. Web Platform Installer
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Una vez Web Platform Installer inicie el instalador de Visual Web Developer,
pulsamos en el botén Instalar.

Figura 11. Instalando Visual Web Developer Express
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Aceptamos las condiciones de uso y el programa de instalaciéon descargard Vi-
sual Web Developer y lo instalara de forma auténoma.

Figura 12. Condiciones de uso

Instalacién de plataforma web m

Revise la siguiente lista de software de aphcacion de terceros y productos y componentes de Microsoft que se van a
nstalar, ast como los componentes de Windows que se van a activar. Las aphcaciones y productos de terceros los
proporcionan los terceros que se enumeran aqui. Microsoft no le concede ningun derecho para el software de terceros.

Usted debe y e5 responsable de buscar, leer y aceptar por separado los terminos de icencia de e5tos terceros

2% Visual Web Developer Express 2010 SP1 [Espadiol] A
Visual Web Developer 2010 Express [Espafiol] (dependencia) 32575 M8
Ver terminos de icencia
+ Termines de privacidad
Rezcargado da hito//g0 mcrozolt con/Znkud=9703963
Visual Studio 2010 SP1 KB983509 [Espadiol] (dependencia) 289,36 M8

Veetiomsinmes do Koswoie

Al hacer chic en "Acepto” expresa su conformidad con los terminos de licencia de software de terceros y de Microsoft
enumerados antenormente. St no esta de acuerdo con todos los terminos de hicencia, haga chic en "No acepto”

0 Ayude 3 mejorar los productos de Microsoft enviando a Microsoft informacion basica sobre la configuracion y uso
para los productos de Microsoft antenores

Declaraciones de privacidad

No acepto l I Acepto

3.1.2. Galeria de plantillas

Al elegir la opcion File > New > Web Site, o hacer clic en el botén equivalente
en la barra de herramientas, vemos la galeria de plantillas instaladas. Cada
plantilla permite crear un tipo de proyecto diferente o contener una serie de
elementos distintos de partida.

En la galeria de plantillas (figura 9) siempre elegiremos la opcién Sitio web
ASP.NET'y, antes de hacer clic sobre el boton Aceptar, estableceremos los para-
metros siguientes:
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e La ubicacién donde se alojara el proyecto, que podré elegirse entre estas
tres posibilidades: Sisterma de archivos, HI'TP y FTP. En nuestro caso siempre
elegiremos Sistema de archivos e indicaremos la ruta donde se alojara el

proyecto.

¢ Ellenguaje de programacion que se utilizara para codificar la logica: Visual
Basic o C#. En nuestro caso, C#.

Una vez establecida la configuracién de la aplicacion, un clic en el botén Acep-
tar generara el proyecto con los médulos iniciales.

3.1.3. Explorador de soluciones

Una vez generado el proyecto, los elementos que lo componen apareceran en
el Solution Explorer (figura 13), una herramienta fundamental para la admi-
nistracion de los proyectos.

Figura 13. El Explorador de soluciones y el menu contextual asociado al proyecto

Solution Explorer
Al el e
A NuevaAplicacion
24 My Project | [53 Build

[ Account Rebuild

3 App_Data Clean

(23 Scripts

(3 Styles 2 Build Deployment Package

3] About.aspx | %% Publish...
| Defaultaspx | (% Package/Publish Settings

#] Globalasax &) View in Browser Ctrl+Shift+W

J stemaster Convert to Web Applicati

3 Web.config onvert to Web Application
Add * | 2] Newltem.. Ctrl+Shift+A
Add Reference... 2 Bdsting Item... Shift+Alt+A
Add Service Reference... (4 New Folder
Add Deployable Dependencies... Add ASP.NET Folder »
Use IS Express... #) Module...

Debug » | ¥g  Class...
Cut Ctrl+X ‘
Paste tri+

&3 Solution Explorer Rename
a2 Properties Alt+Enter

Prower¥

En principio, en esta ventana encontraremos tres elementos: la carpe-
ta App Data, la pégina Default.aspx y el moédulo de configuracién
web.config. La pagina tiene asociado un archivo de cédigo llamado
Default.aspx.cs. Al seleccionar cualquiera de los elementos en la ventana
Properties, apareceran todas sus propiedades. Con el botén secundario del ra-
ton podremos acceder al mena contextual, especifico segtn el tipo de elemen-
to que haya bajo el puntero del ratébn. Un simple doble clic en un elemento
de los mostrados en el Explorador de soluciones nos permitird abrirlo en su
editor/disefiador predeterminado. Recurriendo al ment contextual se puede
optar por abrir el médulo en otro programa, eliminarlo del proyecto, copiarlo
o llevar a cabo tareas especificas.
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El menu contextual asociado al proyecto permite generarlo y ejecutarlo, asi
como agregar referencias y otros elementos. La opcion Add > New element da
paso a un cuadro de didlogo similar al de la figura 14, en el que se encuentran
todos los tipos de elementos que es posible utilizar en una aplicaciéon ASP.NET.

Figura 14. Cuadro de didlogo para agregar nuevos elementos a un proyecto

LMd New Item - Nﬁrr-' - (-2 e
Installed Templates Sort by: i [ search Installed Templates »|
4 Visual Basic - .

Code Web Form Visual Basic Type: Visual Basic
Aform for Web Applications
Data B
General =-=| Web Form using Master Page Visual Basic
Silverlight 5= Web User Control Visual Basic
Online Templates Vi
ﬂ Class Visual Basic |z
Master Page Visual Basic
"] Nested Master Page Visual Basic
ﬂ HTML Page Visual Basic
t}j Style Sheet Visual Basic
@ JScript File Visual Basic
Ven  AJAX-enabled WCF Service Visual Basic
™
ﬁ ASP.NET Handler Visual Basic
%] ASP.NET Module Visual Basic
A ASP.NET Server Control Visual Basic
Name: WebForml.aspx
Add Cancel

3.1.4. EFl disefiador de paginas

En cuanto creemos un nuevo proyecto, o hagamos doble clic sobre un moé-
dulo .aspx en el Solution Explorer, veremos cOmo se abre el disefiador de pa-
ginas ASP.NET. Este se compone de un disefiador visual, similar a cualquier
disefiador web, y de un editor de cédigo XHTML/CSS. En la parte inferior las
opciones Disefio, Dividir y Cédigo permiten alternar entre tres vistas diferentes:
Unicamente los elementos de disefio, el disefiador y el editor, o tnicamente el
editor de coédigo. En la figura 15 puede verse la segunda de las opciones, con
la parte central dividida en dos secciones. La parte superior es el editor y la
inferior el diseflador.

Mientras se trabaja en el disefiador (la parte inferior en la figura 15), es posible
utilizar elementos habituales en el disefio de paginas web. La barra de botones
que hay en la parte superior facilita la seleccion de tipo y tamafio de letra, colo-
res de tinta y fondo, alineacion, incluso de las listas numeradas y sin numerar,
etc. También puede recurrirse a ventanas auxiliares, como Aplicar estilos, Pro-
piedades CSS y Administrar estilos, que facilitan toda la gestion de los atributos
que establecen el estilo de los elementos contenidos en la pagina. Los mendus
Formato y Tabla, activos solamente cuando estd activo el disefiador, ofrecen
opciones adicionales de aplicaciéon de formato e insercién de tablas HTML.
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Figura 15. Disefiador de paginas y editor de céddigo combinados en una misma vista
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En cualquier momento es posible cambiar del disefiador al editor de c6digo  ®En inglés, tag.

y trabajar sobre este. Los cambios llevados a cabo en el disefiador se reflejan
inmediatamente en el codigo y viceversa. Al escribir c6digo, en cuanto intro-
duzcamos el caracter < para iniciar una etiqueta®, el editor nos ofrecera ayuda
inmediata a través de listas de elementos XHTML, atributos CSS, valores que
permite cada atributo, etc. En la figura 16, por ejemplo, puede verse la lista de
valores que permite el atributo style de una etiqueta h2.

Figura 16. No es necesario conocer de memoria los elementos y atributos de XHTML/CSS, el editor nos los recuerda
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Aunque usando el editor XHTML/CSS es posible introducir cualquier elemen-
to en una pagina, por regla general resultard mucho mas comodo hacerlo re-
curriendo a la ventana Toolbox (figura 17). Normalmente, la encontraremos
oculta en el margen izquierdo del entorno.

En el Toolbox, los componentes aparecen agrupados en varias categorias: Va-
lidation, AJAX Extensions, HTML, etc. Los del grupo HTML no son mas que
elementos estandar de XHTML, en ocasiones con algunas propiedades prees-
tablecidas. El resto son componentes de ASP.NET, es decir, porciones de c6digo
que se ejecutaran en el servidor, realizaran un cierto trabajo y generaran como
resultado etiquetas XHTML/CSS.

La inclusion de cualquier tipo de componente en la pagina es una opera-
cién realmente sencilla: no hay mas que tomarlo de la ventana Toolbox y
arrastrarlo hasta la superficie del disefiador. En ese momento en el editor
de codigo se introducira la etiqueta correspondiente, generalmente del tipo
<asp:NombreComponente atributo="valor"...>, y en el diseflador se

apreciard el aspecto del control.

Cada vez que se arrastra un componente desde el Toolbox hasta la superficie
de disefio, lo que se obtiene es una copia, un objeto (una instancia de una
clase), con unos atributos generales. Estos pueden personalizarse modificando
las propiedades que exponen, utilizando para ello la ventana Properties (figura
18).

La modificacién de ciertas propiedades, como las que afectan al estilo del com-
ponente, puede tener un reflejo inmediato en el aspecto del objeto en el dise-
fiador. En otros casos, sin embargo, las propiedades tienen efecto inicamente
durante la ejecucion de la aplicacién, como por ejemplo, la propiedad Auto-
postBack, con la que se rige el comportamiento del componente una vez que
estd en el navegador del cliente, determinando si el cambio de una propiedad
del propio componente provoca 0 no una comunicacion con el servidor.

3.1.5. El editor de cédigo C#

A medida que se va disefiando la interfaz de la aplicacion, colocando compo-
nentes en el disefiador y personalizando sus propiedades, lo habitual es que
también se vaya codificando la 16gica, estableciendo el cédigo que ha de eje-
cutarse cuando se envie un formulario de datos, se cambie la seleccién de una
lista, etc. La introduccion del cédigo en el servidor, que en su mayor parte es-
tara asociado a eventos generados por la pagina o los componentes contenidos
en ella, se lleva a cabo mediante un editor especifico para C#.
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Figura 17. Cuadro de herramientas
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BorderWidth
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Figura 18. Listado de propiedades
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Se puede abrir el editor de codigo de distintas formas:

e Haciendo doble clic sobre un componente para asociar cédigo a su evento
por defecto.

e Usando el botén View Code del Solution Explorer teniendo elegida cualquier
pagina ASP.NET.

¢ Haciendo clic en el botén Events de la ventana Properties desde el disefia-
dor, para acceder a la lista de eventos del componente que se tenga selec-
cionado, y luego eligiendo el evento al que se quiere asociar codigo.

El editor de c6digo, como puede apreciarse en la figura 19, cuenta con dos
listas desplegables en la parte superior. La de la izquierda permite seleccionar
cualquiera de los elementos existentes en la pagina, momento en el que la lista
de la derecha enumerard los eventos que se aplican a ese objeto. La seleccion
de un evento provocaré que el editor genere la cabecera del método encargado
de responder al suceso, de forma que no hay mas que introducir las sentencias
que se quieren ejecutar en dicho caso.

Figura 19. El editor de cédigo de C#
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Al igual que el editor XHTML/CSS, este ofrece también una serie de ayudas
enfocadas a facilitar el trabajo del programador y que se traducen en ventanas
flotantes con informacién acerca de los miembros del objeto cuyo nombre se
ha introducido, la lista de pardmetros que acepta el método al que se pretende
invocar, valores que pueden asignarse a una propiedad, etc.
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A diferencia de lo que ocurre con el codigo XHTML/CSS, el cédigo C# no sera
interpretado ni ejecutado durante la fase de disefio de la aplicacion, por lo que
no tendrd ningtn efecto sobre la interfaz de usuario que se construya parale-
lamente en el disefiador. Se trata de cdédigo que se procesard en el momento
en que la aplicacién sea ejecutada, de ahi que se almacene en un moédulo in-
dependiente.

3.1.6. Ejecucion y depuracion de un sitio web

Dos de las tareas basicas de cualquier desarrollador web es la ejecucién y de-
puracion del sitio en el que trabaja. Con Visual Studio, ambas tareas se realizan
muy facilmente, lo cual es muy util para el programador.

Para ejecutar un sitio web primero debemos especificar la pagina donde se ini-
ciara la ejecucion, ya que podemos tener varias paginas y en Visual Studio es-
tan todas al mismo nivel. Para especificar el punto de entrada de la aplicacion
web pulsamos el botén derecho sobre la pagina en cuestion y seleccionamos
la opcién Set As Start Page.

Figura 20. Establecer como pégina principal

Solution Explorer vOX
2|l 2EEE]e
:‘v’g NuevaAplicacion
=d| My Project
[ Account
[ App_Data
[ Scripts
[ Styles
(| About.aspx
(= Default.aspx
&J Global.asax
=] NuevoWebForm.aspx
7] Site.Master [J Open
=) -
s Web.config Open With...
[Z] View Code
EE] View Designer
View Markup
View Component Designer
View Code Gen File
|} View in Browser Ctrl+Shift+W
Browse With...
Set As Start Page
Exclude From Project
& Cut Ctrl+X
X Delete Del
Rename
= Properties Alt+Enter

Ahora, cuando ejecutemos el sitio web automéaticamente, Visual Studio cargara
la pagina seleccionada. Para ejecutar el sitio web sin depuracién, lo podemos
hacer de diferentes formas:

¢ Seleccionando la opcion del ment Debug > Start Without Debugging.
e Pulsando Ctrl + FS.
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De esta forma podremos ver nuestra aplicacién en ejecucién, pero no podre-
mos depurarla. Para ejecutar nuestro sitio web con depuracién disponemos de

varias opciones:

e Pulsando el botén » de la barra de menda superior.
¢ Seleccionando la opcién del ment Debug > Start Debugging.
e Pulsando F5.

Visual Studio dispone de multitud de herramientas para la depuracion de nues-
tro cédigo. Las mas importantes y Gtiles para nuestro curso son los breakpoints
y los watch de variables.

Un breakpoint, como ya sabemos, es la colocacion de una interrupcion en el
flujo de ejecucion. Para colocar un breakpoint en nuestro c6digo, tnicamente
deberemos ir al archivo .cs y pulsar con el boton izquierdo del raton sobre la
columna izquierda de la fila deseada (figura 21).

Figura 21. Breakpoint en el archivo de cédigo .cs

NuevoWebForm.aspecs® 0 [IERERI ST

5 NusvafiplicaidnWeb Muevo'WebForm

using System;

“Inamespace Huevadiplicacidnieb

{

public partial class Muevolebf : tem, 1.Fage

{

protected woid Page Load{object sender, Eventargs e)

: b
}

- protected vold Buttenl Click{ebfect sender, Eventirgs &)
{
o |[#
}

100 % -

Si lanzamos la ejecucién con depuracién de nuestro sitio y clicamos sobre el
botén, podremos ver como el flujo se para en el breakpoint que hemos insertado
(figura 22).
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Figura 22. Depurando la aplicacién

Nuevo'WebForm.aspocs & X

Yt NuevahplicacidnWeb, Mueve\WebFarm
Susing Systes;

= namespace Nuevabplicacidnieb

{

public partial class NuewokWebForm : tem, I.Page

{

B protected vold Page Load{object sénder, Eventirgs e)

i
I

= protected vold Buttonl Click(object sender, Eventirgs a)
{ -
= 4 Labell.Text = “Depuranda™;|
b

e

Una vez el breakpoint ha saltado, podemos ver el valor de todas las variables que
actualmente tenemos en nuestro contexto. El valor de las variables 1o podemos
consultar en el apartado inferior Watch (figura 23).

Figura 23. Ventana Watch de variables

Watch1 vox
; Name Value ‘ Type o

B Output B Locals PARVERS B

Si pulsamos doble clic sobre la columna nombre podemos insertar el nombre
de la variable que queremos consultar y automaticamente en la columna valor
se actualizara el contenido de dicha variable (figura 24).
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Figura 24. Inspeccionando el valor de una variable

Watch 1 vyvAXx
| Name | Value | Type -
7 Labell. Text Q +|string

B Output B Locals PRUEI B

Para avanzar el flujo de ejecucién una vez parado en nuestro breakpoint, dis-

ponemos de los botones %z [Z de la barra de mena superior. Si avanzamos
una linea el flujo de ejecucién veremos como la variable cambia de valor au-

tomaticamente (figura 25).

Figura 25. Inspeccionando el valor de una variable

Watch1 vyOXx
| Name | Value | Type -
1 Labell . Text "Depurando” % ~| string

B Output B Locals PARVER B

Finalmente, si queremos retomar la ejecucion normal de la aplicacion, Gnica-

mente debemos pulsar otra vez el boton ».

3.1.7. Base de datos compacta con Visual Studio

En la mayoria de aplicaciones web es necesaria una base de datos de donde
recoger la informacion. Para aplicaciones extensas puede ser necesaria una
base de datos convencional que necesite de un servidor de base de datos para
su funcionamiento, pero para proyectos pequefios como son los nuestros, una
base de datos compacta (de un solo archivo sin necesidad de servidor) es mas
que suficiente. Visual Studio nos permite la creacién de ambos tipos de base
de datos desde el mismo entorno de programacion.

Creacion de la base de datos

Nosotros nos centraremos en la creacion de una base de datos compacta me-

diante Visual Studio.

Primero de todo accederemos al apartado del ment Tools > Connect to Database.
Seleccionamos Microsoft SQL Server Compact 4.0 y pulsamos OK (figura 26).
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Figura 26. Tipo de base de datos

(9 i

Change Data Source

Data source:

Microsoft Access Database File
Microsoft ODBC Data Source Use this selection to connect to a
Microsoft SQL Server Microsoft SQL Server Compact 4.0
database file.

Microsoft SQL Server Database File
Oracle Database

<other>

Description

Data provider:
’.NET Framework Data Provider for Micrc vl

[] Always use this selection ’ 0K l [ Cancel

En la siguiente ventana, asignamos un nombre a nuestra base de datos en el
apartado Database, por ejemplo “NuevaBaseDatos”. En el apartado Password
introducimos una contrasefia, por ejemplo “uoc”, y pulsamos Create (figura
27). Una vez creada la base de datos, pulsamos OK y veremos como en el Da-
tabase Explorer nos aparece una nueva base de datos NuevaBaseDatos.sdf (fi-

gura 28).

Figura 27. Aiiadiendo la conexién a la base de datos

Add Connection M

Enter information to connect to the selected data source or click
"Change" to choose a different data source and/or provider.

Data source:
Microsoft SQL Server Compact 4.0 (NET Frame

Data Source
© My Computer

ActiveSync Connected Device

Connection Properties

Database:

NuevaBaseDatos

Create... H Browse...

Password:

[] Save my password

Test Connection OK

Creacion de tablas

Para la creacién de tablas, inicamente deberemos pulsar el botén derecho so-

bre Tables y seleccionar Create Table (figura 29).

Database Explorer

RINEN R

4 (3] Data Connections
4 | [ NuevaBaseDatos.sdf
1 Tables
> [ Replication

MY Solution Explorer [EEN - EE eI

Figura 28. Base de datos compacta
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Figura 29. Creacién de tablas

Database Explorer

= | %

BT
[ |

i [e]

4[] Data Connections
4 [J; NuevaBaseDatos.sdf

vAax
Create Table
New Query
Refresh
Properties Alt+Enter

LRSI 8 Database Explorer

A continuacién nos aparece una ventana donde podremos especificar el nom-

bre y los campos de la tabla. Vemos que es muy parecido a otros gestores de

bases de datos; para cada columna debemos especificar el nombre del campo,

el tipo, si debe ser tnico, si puede estar vacio y si es clave primaria. Una vez

rellenados los campos, pulsamos OK (figura 30). Esto nos generara nuestra pri-

mera tabla (figura 31).

Figura 30. Formulario de nueva tabla

l vie
%7 General

|2) Refresh [ Help

TR W —— e
, =

Name: PrimeraTabla

Column Name Data Type Length  Allow Nulls  Unique Primary Key
id int 4 No Yes Yes
s nombre nvarchar 100 Yes No No
Default Value
Identity False
Identity Increment
Is RowGuid False
Microsoft SQL Server Compact Precision
Scale
NuevaBaseDatos.sdf
Default Value
37 View connection properties Default value for this column.
View connection properties
OK ] I Cancel

Database Explorer
=1 %%
4 [}J Data Connections
4 % NuevaBaseDatos.sdf
4 [ Tables
> [-2] PrimeraTabla
> [3 Replication

vyAax

LTSI 7 Database Explorer

Figura 31. Nueva tabla
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Nos queda poder crear claves foraneas entre nuestras tablas. Para ello creamos
una nueva tabla llamada “SegundaTabla” (figura 32). Pulsamos el botén dere-
cho sobre dicha tabla una vez creada y seleccionamos la opcién Table Proper-
ties (figura 33).

Figura 32. Edicién de tabla

= a
— — —
l vie |2) Refresh [ Help |
%7 General U
Name: SegundaTabla
Column Name Data Type Length  Allow Nulls  Unique Primary Key
fid int 4 No No Yes
idPrimera int 4 No No No
Default Value
Identity False
Identity Increment
Is RowGuid False
Microsoft SQL Server Compact Precision
Scale
NuevaBaseDatos.sdf
Default Value
33 View connection properties Default value for this column.
View connection properties
OK l I Cancel

Dentro de las propiedades vamos al apartado Afiadir relaciones y rellenamos
los campos de dicho apartado teniendo en cuenta que la columna izquierda
corresponde a la clave primaria de la tabla origen y la columna derecha corres-
ponde a la tabla actual, donde debemos escoger la columna que sera clave fo-
ranea. Pulsamos Add Columns y automaticamente se afiadira la nueva relaciéon
de clave foranea entre las tablas (figura 34).

Database Explorer
= |
4 () Data Connections
4 [J; NuevaBaseDatos.sdf
4 [ Tables
> [Z] PrimeraTabla

e P
. L;j _R Drop Table
Table Properties
Edit Table Schema
New Query
Show Table Data
Copy Ctrl+C
Refresh

Properties

I I

Alt+Ente

Lo RTINS “a Database Explorer

Figura 33. Edicion de tabla
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Figura 34. Afiadiendo clave foranea

=
(] Table Properties - SegundaTabla

- W

{f View

|| %7 General

%F Column

257 Add Relations
F Manage Relations

Connection

Microsoft SQL Server Compact

NuevaBaseDatos.sdf

|2) Refresh [ Help

Create Relation

Relation Name

Update Rule: Delete Rule:

NO ACTION -] [noacTion
Primary Key Table Foreign Key Table
PrimeraTabla v SegundaTabla

Primary Key Table Column

Foreign Key Table Column

[ia

VI [idPrimera

( Add Columns

Manage Rules in Relation

Selected Columns for Relation

Primary Key Table Column
id

Foreign Key Table Column

idPrimera

Delete Columns

Add Relation

47 View connection

ok ][ conce

Insercion y ediciéon de datos

Una vez creada la base de datos con sus tablas relacionadas, inicamente nos
queda insertar los datos necesarios. Para ello pulsamos el botén derecho sobre
la tabla donde queramos insertar datos y seleccionamos la opcién Show Data
Table (figura 35).

Figura 35. Afadiendo datos a la tabla

Database Explorer
2] 1| %%
4 [} Data Connections
[J; NuevaBaseDatos.sdf

4 [ Tables
» =] PrimeraT--!~
> [&] Segunda Drop Table
[ Replication Table Properties
Edit Table Schema
New Query
[j Show Table Data
Ea Copy Ctrl+C
[2] Refresh
f= Properties Alt+Enter
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Finalmente veremos una tabla que podremos editar afladiendo o modificando
filas a nuestro antojo (figura 36).

Figura 36. Afadiendo datos a la
tabla

PrimeraTabla: Quer...uevaBaseDatos.sdf) X ]

id nombre

1 nombrel

2 nombre2
»# | NULL

Manejo de la base de datos desde codigo

1) Seleccion de datos

Para manejar la base de datos desde el cédigo C#, ya sea para insertar, editar o
consultar, lo primero que debemos hacer es abrir una conexién con la misma.
A continuacién veremos un pequefio ejemplo donde seleccionaremos datos

de la base de datos y los cargaremos en un combo.

Primero de todo definimos en el archivo aspx el combo donde se cargaran los
datos y un botén para lanzar el evento que consultara la base de datos.

Figura 37

Nuevo'WebFormoasps® X

Client ﬂl:jedl& Events - {Mo Events)
<Xf Page Language="C#" AutcEventiireup="truve” CodeBehind="MusvakebForm.aspx.cs™ Inherits="Huevadppueb.NusvokebFora™ X

<!DOCTYPE html PUBLIC "=//W3C//OTD XHTML 1.8 Transitiomal/JYEN" “"http://wew.w3.org/ TR xhtmll/OT0 xhtmll-transitional.dtd™>

<hitm]l xmlns="http:/  wew. wi. org/ 1999 xhtm]l™ >
Sl<head runat="seryen":
dtitles</titler
< head>
SEA LT
= <form id="forml™ runat="serwver™r
cdive
<aspiButton runats™server™ onclicks"CargarDesplegable Click™ Text="Cargar Desplegable”/:
<asp:Droplownlist runat="server” ID="DropbownSelect”»</fasp:0ropbownlist>
< fdlve
< forms
o« Mheady >

</ html >

A continuacién, en el archivo aspx.cs definimos el evento del botén
con el codigo de conexién y seleccion de base de datos. Vemos cémo
se define la biblioteca de Sql Server Compact con la instruccién using
System.Data.SglServerCe. Segln la version de Visual Studio, es posible
que no tengais la biblioteca (dll) a la que se hace referencia. La encontraréis
en el espacio de ficheros del aula.
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Figura 38
T e
1§ NuoalppWeb MecxWebForm = | ¢ CargarDesplogable Clickiobpect sender, EvertAngs &)
using Fystem.web.Ul.Heblontrols;
using Syites.Dets . 5glterverie;
NasESRAcE Hudyasppeh
{
public partial class
{
public static teetrings liztaTotal = new <ekring»();
protected vold Page Losd({cbject sender, )
{
protected wold Cargarpesplegable Click{obiect sender, targs &)
£
11 Con = AW ¢ Y (B Datadource="0: Wiers\Franclsce Ortege i Decusent s WiseveBateDatos . 40F " ; Pasawsrd="us"");
con. Open( )2
Lo = PEw CeCommand( “SELECT nosbere FROM PriseraTabla®™, con);
reader = com.ExeuteResder():
while {(reader.Read(})
OrophownSelect]. Ttems , add( new tesresder] “rosbre™ ], TeSteing( ) );
1
con.Close();
}
]

Comentaremos linea por linea el c6digo que podemos ver en el evento de
botén del servidor:

SglCeConnection con = new SglCeConnection (@"DataSource='D:\Users\Francisco.Ortega\

Documents\NuevaBaseDatos.sdf'; Password='uoc'");
Primero de todo conectamos con la base de datos con la clase SgqlCeConnec-
tion pasandole la ruta del archivo de base de datos creado anteriormente y
la contrasefia de la misma.

con.Open () ;

Es necesario abrir la conexién con la base de datos para poder empezar a rea-

lizar operaciones con ella.

SglCeCommand com = new SglCeCommand ("SELECT nombre FROM PrimeraTabla", con);

Creamos la consulta que realizaremos a la base de datos con el objeto Sql1-

Command pasandole la conexién que hemos creado.

SglCeDataReader reader = com.ExecuteReader () ;
Para ejecutar la consulta utilizamos la funcién ExecuteReader (). Esta fun-
cién nos devuelve los resultados de la consulta que almacenamos en un objeto

de tipo SglCeDataReader.

while (reader.Read())
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DropDownSelect.Items.Add( new ListItem(reader["nombre"].ToString()));

Vamos recorriendo el SglCeDataReader con un while extrayendo en ca-
da iteracion una fila del resultado con la funcién Read (). Una vez extrai-
da la fila accederemos a los campos de bases de datos mediante la notacién

reader ["nombreCampo"].

con.Close();

Una vez realizadas todas las operaciones con la base de datos, cerramos la

conexion para no sobrecargarla.

Si ejecutamos la aplicacién, podemos ver como el combo se carga con la con-

sulta de la base de datos al pulsar el boton Cargar Desplegable (figura 39).

Figura 39

e )[@ hitp://tocalnost:4178/NuevowebForm.aspx L~ 2 x| s

@ localhost

! Cargar Desplegable || Juan E] I

#®100% ~

2) Edicion de datos

Para la edicién de datos de la base de datos, igual que en la seleccion, debere-

mos abrir una conexién con la misma.

Continuando con el ejemplo anterior, afiadiremos un TextBox, donde inser-

taremos el valor que queremos que reemplace a la selecciéon del combo.
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Figura 40

HuevoWebFormoaspe® = JEIaRaIUE

(hent Objects & Events - [Ma Events)
<X Page Languages"CE"™ dutoEventWireupe“true™ CodeBehinde“NuevodebForm.atpx.ct™ Inheritz="Nuevaippiieb.NusvokebForn” %>

<|DOCTYPE himl PUBLIC “-//W3C//0TD XHTHML 1.8 Transitiomal//EN™ “http://fwww.w3.org/TR/=htmll/DT0/xhtmll-transitional . dtd">

chtm]l welnss"http:/ wew Wi, org 1995 chital™>
—¢head runats” server >
titlexd/title»
€/ head>
= <body>
- iform id="forsl® runat="server®>
- <five
aspiButton renate"server™ onclick="CargarDesplegable Click™ Text="Cargar Desplegable™/>
<asptDropDownlist runat="server”™ ID="DropDownSelect™»< asp:DropDownlist>

caspiTextBox ID="TextBoxEditar™ runat="ferver < fatp:TextBoxs
<asp:Button renat="server™ onclick="EditarSeleccion_Click™ Text="Editar seleccidn™/>
o fdivs
& fForm>
« [ body >
& html»

Ademads, como podemos ver, hemos afladido un botén que lanzara el evento

de edicién del campo del combo con el valor del TextBox.
Figura 41

protected vold EditarSeleccion Click(object sender, Eventirgs )
{
SqleConnection con = mew Sqllefonnection{@™DataSources"D:\Users\Francisco.Ortega\Docusent s\MuevaBaseDatos. sdf "}
Password="woc ")
con.Open();
var itemSelected = DropDownSelect.SelectedItes;

if(15tring. IsNullOrEmpty | TextBoxEditar . Text))
{
SglCelommand com = new SqlCelommand(“UPDATE PrimeraTabla 5SET nombre=""+
TextBoxEditar.Text #°° WHERE nombres'"+ itemSelected.Text +°°[', con);:
com_ExecuteNonfuery();
}

con.Close();

Podemos ver que la parte de conexién y desconexién con base de datos es
idéntica a la del ejemplo anterior, tnicamente varia la creacién y ejecuciéon
de la consulta.

SglCeCommand com = new SglCeCommand ("UPDATE PrimeraTabla SET nombre='" +

TextBoxEditar.Text + "' WHERE nombre='" + itemSelected.Text + "'", con);

Utilizando el mismo objeto SglCeCommand creamos query de Update pasan-
dole la conexion a la base de datos.

com.ExecuteNonQuery () ;
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Para una edicién de datos se debe utilizar la funcién ExecuteNonQuery (),
en lugar de ExecuteReader ().

Si ejecutamos la aplicacién, veremos como, si insertamos un valor en el Text-
Box, seleccionamos un valor en el select y pulsamos Editar seleccion, el valor
del desplegable se actualiza cuando volvemos a pulsar Cargar Desplegable.

Figura 42
- - - - — e - | @ = J
C)l@ http://localhost4178/NuevoWebForm.aspx o-2ex| Y
= - Kl - —
@ localhost X
' Cargar Desplegable [Juan E Fran
®100% v

3) Insercion de datos

La inserciéon de datos es practicamente idéntica a la edicion. Continuando
con el ejemplo, afladiremos un TextBox, donde especificaremos la cadena de
caracteres que insertaremos en la base de datos.

Figura 43

NueveWebFormoasps % Qrrm.;
| Chent Objects & Events -] (No Events)

«X§ Page Languages="C8™ AutoEventiireupstrue® CodeBehind=“NuevokebForm.aspx.cs™ Inherits="Nuevasppheb . NusvokebForm®™ s

<IDOCTYPE html PUBLIC “-//W3C//OTD XHTHL 1.0 Tramsitional/fEN™ “http://fwew.wd.org/TR/xhtell /OTD/xhtmll-transitional . ded™>

=l<html wmlns="http: /o . w3 . org/ 1999/ xhtml™>
—lthead runateserver™>
ctitlerd/ ritle>
o fhead>
--thﬂdy:
= «form ide"forml™ runat="server®:
Sdivy
<aspiButton runat="server” onclick="CargarDesplegable Click™ Text="Cargar Desplegable™/»
<asp:DropbDownList runate"server™ [Dw"DropDownSelect™»<fasp:DropDownLists

<asp:TextBox ID="TextBoxEditar™ runats="server »<fasp:TextBox»
<asp:Button runat="server® onclick="EditarSeleccion_Click®™ Text="Editar seleccidn™/»

casp:TextBox IDs"TextBoxInsertar™ runats™server™ »< asp: TextBox»
caspiButton| runat="server™ onclicke="Insertarfosbre Click® Text="Insertar nosbre™/»
< fdive
£ Sfares
< Moy >
<lhtml s
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Ademas, afiadimos un botén que lanzar el evento de insercién en la base de

datos.
Figura 44
protected wvold Inzertarbosbre Click(cbject sender, Eventargs e)
{
& A% con = néw 5gqlce ect (B DataSource="D:Wiers\Francisco . Ortega\Document s \MivevaBaseDatos. sdf "
Password="udd" ")}
con.Open();
if (!5tring.IsMullOr-Empty | TextBoxInsertar. Text))
r
i
1 { com = few 1 d(“INSERT INTO PrimeraTabla (nombre)VALUES{@nombre}™, con);
com.Parameters. Addwithvalue(“Enosbre™, TextBoxInsertar.Text);l
com, Executelionluery();
1
con.Close();
}
}
}

El cédigo que varia con respecto a la edicion de datos es el que concierne a la
creacion de la query de insercién.

SglCeCommand com = new SglCeCommand ("INSERT INTO PrimeraTabla (nombre)VALUES (@nombre)", con);

com.Parameters.AddWithValue ("@nombre", TextBoxInsertar.Text);

Primero creamos la query de insercion especificando los valores que inserta-
remos con la notacién @nombreCampo. A continuacion especificamos dichos
valores con la funcién Parameters.AddWithvalue () pasandole el identifi-
cado @nombreCampo Yy el valor que queremos insertar. Si ejecutamos la apli-
cacion, insertamos un valor en el TextBox y pulsamos el botén Insertar nom-
bre, veremos como la cadena se inserta en la base de datos. Para poder verlo,
refrescaremos el combo pulsando Cargar Desplegable.

Figura 45
- - |lol®| =
J(E9)[@ http://tocalhost:4178/NuevowebForm.aspx o-2e x| iy
€ loclhost * . t'
Cargar Desplegable | [~] Martin

®100% ~
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4. Introduccion a ASP.NET

ASP.NET es una de las tecnologias que integra .NET mediante la cual los desa-
rrolladores pueden crear aplicaciones web.

En este apartado se explicaran las caracteristicas mds destacables de ASP.NET,
se hara una breve introduccion histérica desde los principios de ASP.NET hasta
ASP.NET 4.0. A continuacién, se comenzara a ver una introduccién a la tecno-
logia ASP.NET, explicando lo que son los WebForm, los controles de servidor
o las MasterPage.

4.1. Caracteristicas principales de ASP.NET

En ASP.NET hay siete factores o caracteristicas clave que lo diferencian de los
demas productos de Microsoft y de las plataformas de la competencia. Estas

caracteristicas son las siguientes:

1) ASP.NET estéa integrado con el entorno de desarrollo .NET Framework.
El entorno .NET Framework es un conjunto de miles de clases, estructuras, in-
terfaces, etc., que estad organizado segin su funcionalidad. El modo de utilizar
las clases de .NET en ASP.NET es el mismo que en cualquier otro tipo de plata-
forma .NET. En otras palabras, la utilizacién del entorno de desarrollo .NET es
la misma en una aplicacién web que en una de escritorio. Esta caracteristica es
verdaderamente importante porque implica que Microsoft ofrece las mismas
herramientas a los desarrolladores web que a los programadores de aplicacio-
nes cliente.

2) ASP.NET es compilado, no interpretado. Las aplicaciones ASP.NET, al igual
que todas las aplicaciones .NET, siempre se compilan. Esta compilacién pasa
por dos etapas bien diferenciadas. En la primera etapa, el codigo C# se trans-
forma en un lenguaje intermedio llamado Microsoft Intermediate Language
(MSIL). Esta etapa permite que las plataformas .NET sean multilenguaje, es
decir, que se pueda programar en diferentes lenguajes de programacién, como
C# o Visual Basic. La segunda etapa de compilacion transforma el codigo MSIL
en codigo maquina. En la figura 46 podemos ver un diagrama con las diferen-
tes etapas de compilacion.
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Figura 46. Etapas de compilacién de ASP.NET
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3) ASP.NET es multilenguaje. Como hemos visto, gracias a la primera etapa,
cualquier plataforma .NET puede ser multilenguaje. Unicamente necesitamos
un compilador que transforme el lenguaje en el cual programamos al lenguaje
intermedio MSIL. Los dos lenguajes de programacion por excelencia en .NET
son C# y Visual Basic.

4) ASP.NET es orientado a objetos. En ASP.NET se pueden explotar todas las
caracteristicas de una programaciéon orientada a objetos. Por ejemplo, se pue-
den crear clases reutilizables, estandarizar el c6digo utilizando interfaces o ex-

tender clases mediante la herencia.

5) ASP.NET es compatible con todos los navegadores. Uno de los mayores
desafios a los que se enfrenta un desarrollador web es la gran cantidad de na-
vegadores que hay en el mercado. ASP.NET aborda este problema de forma
bastante innovadora: anima a los desarrolladores a utilizar una serie de con-
troles de servidor. Estos controles son funcionales en cliente solo si este sopor-
ta todas sus caracteristicas.

6) ASP.NET es facil de desplegar y configurar. Uno de los mayores quebrade-
ros de cabeza a los que se tiene que enfrentar un desarrollador es el despliegue
de una aplicacién web en un servidor real.
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7) Otro aspecto destacable de ASP.NET es su facil configuracién, ya que toda
la plataforma esta unificada en un solo archivo web.config. En este archivo
podemos configurar desde permisos de acceso a cadenas de conexion de base
de datos.

4.2. La evolucion de ASP.NET

Cuando Microsoft lanz6 al mercado ASP.NET rapidamente se convirtié en el
estandar para desarrollo web con tecnologia .NET y en un duro competidor
para las otras plataformas de desarrollo web.

Desde entonces, Microsoft ha creado varias versiones de ASP.NET. En los si-
guientes subapartados se explica como ASP.NET ha ido evolucionando a lo
largo de los afios.

4.2.1. ASPNET 10y 1.1

La idea central de ASP.NET fue crear un modelo de paginas web llamado for-
mularios web. Bdsicamente, cuando un navegador solicita una pagina ASP.NET,
crea en el servidor un objeto Page y tantos objetos como controles tenga dicha
pagina. De esta forma, el desarrollador puede modificar aspectos de la pagina

en tiempo de ejecucion.
4.2.2. ASP.NET 2.0

La version 2.0 mantuvo el mismo modelo de formularios web y se concentr6
en la adicién de nuevas caracteristicas de alto nivel como:

Paginas maestras. Las MasterPage, o paginas maestras’, son plantillas para
la reutilizacién de cédigo, como por ejemplo en encabezados o pies de
pagina.

e Navegacion. Se incluyen diferentes controles de navegacién como el arbol,
el mapa del sitio o el hilo de Ariadna.

e Seguridad. Incluye soporte para el almacenamiento de credenciales de

usuario y nuevos controles de servidor para el acceso®, el registro de usua-

rio o el recordatorio de contrasena.

e Origen de datos. La version 2.0 permite enlazar controles de servidor con
diferentes fuentes de datos como bases de datos o XML.

©En inglés, master pages.

©Fn inglés, login.
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4.2.3. ASP.NET 3.5

La principal novedad que se puede destacar de la version 3.5 es la introduccién
de dos nuevas tecnologias: Linq y Ajax.

La primera tecnologia es un conjunto de ampliaciones para C# o Visual Basic,
que permite manipular datos en memoria (por ejemplo, una lista) de la misma
manera que lo hariamos con consultas a una base de datos.

En las versiones anteriores de ASP.NET, para cada peticion desde el navegador,
el servidor debia procesar toda la padgina entera y volverla a enviar al servidor.
Este proceso resultaba lento e ineficiente, ademas de ser poco interactivo desde
el punto de vista del usuario. Para solucionar este problema se implemento la
tecnologia AJAX para ASP.NET, que mediante JavaScript es capaz de realizar
recargas parciales de una pagina web. La figura 47 ilustra las diferencias entre
las peticiones tradicionales y las peticiones AJAX.

Figura 47. Peticiones tradicionales y peticiones Ajax

Actualizaciones normales de pagina con ASP.NET

Peticidon de actualizacion

»
»

ASP.NET

<
<«

Respuesta con la pagina completa

Actualizaciones de pagina con AJAX

Peticidon de actualizacion

»
»

ASP.NET

A

Respuesta con la porcién de pagina a actualizar

4.2.4. ASP.NET 4.0

En la version 4.0 de ASP.NET, las nuevas caracteristicas aportadas son algo mas
sutiles. Alguna de ellas son:

¢ Renderizacion en XHTML. Después de procesar la pagina correspondiente
a la peticion, se envia al cliente en el estindar XHTML.

e Control de ViewState. Se incorpora la activacion/desactivacion del ViewS-
tate. El ViewState es un objeto que ASP.NET va transmitiendo entre las lla-

madas asincronas donde se almacena informacién de la pagina.
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e Control de gréficos. Se incorpora un control para la realizacién de diferen-
tes graficos, como graficos de lineas, barras, curva, superficie, circulares,
de anillos y graficos de punto.

e Enrutamiento. Tecnologia para poder redirigir peticiones web al igual que
hacen la mayoria de los patrones de disefio modelo-vista-controlador.

4.3. Estructura de una aplicacion ASP.NET

La estructura de una aplicacién web clasica consiste en una arquitectura clien-
te-servidor segin la cual existe un servidor y uno o varios clientes que acceden

al mismo (figura 48).

Figura 48. Arquitectura cliente servidor

Cliente (navegador web) Servidor (servidor web)
Internet Explorer Solicitud s
Firefox Apache
Chrome ’ Respuesta httpd

Dicha estructura es utilizada también en una aplicacién ASP.NET. Ademas, las
aplicaciones ASP.NET son ejecutadas en el servidor por una capa de software,
conocida habitualmente como motor de ASP.NET, que es la encargada de inter-
pretar la solicitud que le facilita el servidor web y generar un objeto Ht tpRe-
quest con toda la informacién. En este objeto estaran contenidos, por ejem-
plo, todos los datos introducidos en los formularios por el usuario, el navega-
dor utilizado o la informacién de estado de la aplicacion.

Cada péagina de un proyecto ASP.NET se compone al menos de dos médulos:
uno con extension . aspx, en el que esta contenido el codigo XHTML estético,
y otro con la extensién .aspx.cs, que aloja el c6digo C# correspondiente a

la légica de la aplicacion.

La primera vez que se recibe una solicitud para una péagina, el motor de
ASP.NET la compila y obtiene una version lista para ejecutarse, que se aloja en
memoria. En las solicitudes siguientes la respuesta serda inmediata, ya que se
dispone de una versiéon compilada.

En la figura 49 se muestra un esquema de bloques de los elementos que for-
man una aplicacién ASP.NET. Como se puede ver, el cliente siempre obtendra
como respuesta una combinacién de XHTML, CSS y JavaScript, lenguajes va-
lidos para cualquier navegador web con independencia de la plataforma que
se utilice para realizar la peticion.
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Figura 49. Arquitectura ASP.NET
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4.3.1. Tipos de archivos en ASP.NET

Las aplicaciones web en ASP.NET pueden tener diferentes tipos de archivos,

algunos de los cuales se muestran a continuacion:

e _.aspx: son las paginas web en ASP.NET. Contienen la interfaz de usuario.
El punto de entrada para los usuarios siempre es uno de estos archivos.

e .ascx:son los controles de usuario en ASP.NET. Son similares a las paginas
web, pero no son accesibles directamente desde el navegador, sino que
siempre forman parte de una péagina. Se utilizan para reutilizar cédigo y

evitar asi la repeticién del mismo.

* web.config: archivo de configuraciéon en XML. Desde aqui se configuran

aspectos de seguridad, memoria, conexiones a bases de datos, etc.

* global.asax: es el fichero global de la aplicacién. Aqui se pueden definir
variables globales, accesibles desde cualquier pagina, y eventos propios de
la aplicacion.

e _cs: archivo de cédigo C#. Nos permite separar la 16gica de la aplicacion
de la interfaz de usuario.

Ademas de estos archivos, las aplicaciones ASP.NET pueden contener otros
archivos comunes en muchas aplicaciones web, como archivos JavaScript,
HTML, CSS o imagenes.
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4.4. ;Qué son los WebForm?

Las Pages o, como oficialmente se conocen, los WebForm son la parte mas
importante de una aplicacion ASP.NET. Estos WebForm generan todo el cédi-
go HTML de respuesta a cualquier peticién que solicita un cliente desde el na-
vegador. Cada WebForm que afladimos a nuestra aplicaciéon serd una pagina
accesible por el usuario. Un WebForm esta compuesto por dos archivos de c6-
digo, un archivo .aspx, donde reside todo el codigo de la interfaz de usuario, y
un archivo .aspx.cs, con todo el cddigo relacionado al WebForm como even-
tos, validaciones, etc.

A continuacién podemos ver un ejemplo de un WebForm donde se muestran

ambos ficheros:

Figura 50. Ficheros .aspxy .cs de un WebForm

| Client Objects & Events -
<&@ Page Language="(#" AutoEventWireup="true"” CodeBehind="NuevoWebForm.aspx.cs™
Inherits="Nuevafplicacidnieb.NuevolebForm" %>

<!|DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8 Transitional//EN"
"http:/ vww. w3, org/TR/xhtml1/DTD/xhtmll-transitional.dtd">

<html xmlns="http://we.w3.0rg,/ 1999 xhtml" >
<head runat="server"”>»
<titles</title>
¢/head>
<body>
¢<form id="forml" runat="server">
<div>

<fdiv>

</form»
</body>
</html>

NuesvoWebForm.aspr.cs X [T E

“t$ NuevaAplicacionWeb.MuevoWebForm ..l 5

Fusing System;

[=inamespace NuevaAplicacidnWeb

=] public partial class NuewvollebForm : Sy eb.UI.Page
{
- protected void Page_lLoad(cbject sender, Eventirgs e)
{
}
}
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Internamente, un WebForm o Page se genera gracias a la clase Page, como
hemos podido ver tanto en la cabecera del fichero . aspx como en la herencia
del fichero .cs. Posteriormente se dedicard un apartado para explicar mas
profundamente dicha clase, una de las mas importantes de la biblioteca de
clases de .NET.

4.4.1. Aiadiendo un WebForm a nuestro sitio web

Para afiadir un WebForm a un sitio web creado previamente, tnicamente de-

bemos seguir los siguientes pasos:

e Pulsamos el botén derecho sobre la raiz del proyecto, o sobre cualquier
carpeta donde queramos que se aloje el WebForm, para abrir el ment con-

textual y a continuacion pulsamos Add > New item.

e A continuacion seleccionamos la plantilla WebForm, le damos un nombre

a nuestra pagina y pulsamos Add (figura 51).

Figura 51. Afadiendo un WebForm

Add New Item - NuevaApli -
Installed Templates Sort by: [ search Installed Templates »|
4 Visual Basic = .

Code == WebForm Visual Basic Type: Visual Basic
- Aform for Web Applications
Data R
General Z°E| Web Form using Master Page Visual Basic
Web
Silverlight 5= Web User Control Visual Basic
Online Templates P
\ﬂ Class Visual Basic |z
[ Master Page Visual Basic
Nested Master Page Visual Basic
ﬂ HTML Page Visual Basic
AL stylesheet Visual Basic |
f
Q IScript File Visual Basic I
E& AJAX-enabled WCF Service Visual Basic
g ASP.NET Handler Visual Basic
g ASP.NET Module Visual Basic
T4 ASP.NET Server Control Visual Basic  ~
Name: NuevoWebForm.aspx
Add Cancel
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e Si desplegamos en el Solution Explorer nuestro WebForm, podemos ver los
archivos .aspx y .aspx.cs (figura 52).

e Finalmente, podemos explorar ambos archivos en el editor de c6digo co-
rrespondiente pulsando doble clic en cada uno de ellos.

4.5. La clase Page

Cada péagina de una aplicacion web en ASP.NET hereda de la clase Page. Me-
diante esta herencia nuestras paginas adquieren una serie de propiedades y
métodos que podemos utilizar en los ficheros . cs.

A continuacién enumeraremos algunas de las propiedades mas importantes:

e IsPostBack: booleano que indica si es la primera vez que la pagina se
ha cargado.

¢ EnableViewState: booleano. Nos permite decidir si queremos guardar la

informacién de estado de los controles entre peticiones.

e Application: coleccidon que contiene informacidon compartida entre to-
PP

dos los usuarios del sitio web.

* Session: coleccién que contiene informacién de un usuario en particular

que se mantiene entre diferentes peticiones.

* Request: coleccién que contiene informacién sobre la peticiéon actual co-
mo informacién del navegador o los pardmetros enviados.

e Response: objeto HttpResponse relacionado con la respuesta a una de-
terminada peticion. Se puede utilizar para redireccionar al usuario a otra
pagina, enviar cookies al navegador, etc.

Un caso muy comn donde se utiliza una propiedad de la clase Page es en
la redireccion del flujo hacia otra pagina web. Concretamente, se utiliza la
propiedad Response.

Para ver un ejemplo insertaremos en un WebForm tinicamente un Button con

su respectivo evento de servidor.

Solution Explorer vyaXx
alalla| @
2 Solution ‘NuevaAppWeb' (1 project)

(‘A NuevaAppWeb

=d| Properties

«3) References

[ Account

3 App_Data

[ Scripts

3 Styles

ﬂ About.aspx

E2]] Default.aspx

4] Global.asax

] NuevoWebForm.aspx
‘%) NuevoWebForm.aspx.cs
‘%] NuevoWebForm.aspx.designer.cs

7] Site.Master

i Web.config

»—‘? Solution Explorer | i MEETNS" IS

Figura 52. Afiadiendo un WebForm
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Figura 53. Cédigo .aspx de un WebForm

|  Client Objects & Events -] (Mo Events)

age Language= AutoEventiireup="true” CodeBehind="NuevolebForm.aspx.cs
Pag guage="C#" AutoE ireup="true" CodeBehind="H bF .
Inherits="NuevafAplicacidnieb.NuevoiebForm™ X>

<[DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN™
“http:/ St w3. org/ TR/ xhtmll /DTDS xhtmll-transiticnal .dtd"»
Sl<html xmlns="http://wew.w3.org/1999/xhtml ">
=l<head runat="server">
<titler</ritles
</head>
—l<body>
= <form id="forml® runat="server":»
=] <div:
<asp:Button ID="Buttonl® runat="server" Text="Button®™ /»
<fdiv>
</form>
| </body>
| </html>

Figura 54. Cédigo .cs de un WebForm

TR T L PR el MuevoWebForm.aspx®

“t NuevafplicaciénWeb.MueveWebForm =|#¥Bu
Slusing System;
zing S em.Collections.Generic;

-Inamespace NuevaAplicacidnieb

= public partial class NuevolebForm : System.Web.UI.Page
{
= protected void Page Load(object sender, Eventargs e)
{
}
= protected woid Buttonl Click(object sender, Ev
i
¥
i
}
W% - 4

En el evento click del botén hacemos una redireccién hacia otra pagina web
de la siguiente manera:
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Figura 55. Cédigo .cs de un WebForm

MNueveWebForm.aspr.cs™ X

| i NuevaAplicacidnWeb.MuevoWebForm

'I % Butte

Flusing System;
ing System.Collections.Generic
em.Ling;

eir

usl

JHebs
using 5 JHeb.UI;
using System.Web.UI.wWebControls;

B =¥ ¥

~Inamespace Muevadplicacidnieb

= public partial class NuevokebForm : System.Web.UI.Page

i
=] protected void Page Load(cbject sender, Eventirgs e)
{
H
= protected vold Buttenl Click(object sender, Eventirgs e)
{
Response.Redirect("http://www.google.es") ;|
}
| 1
L}
0% = -«

Si ejecutamos, veremos que cuando pulsamos en el botén (figura 56) el flujo

se redirecciona hacia la URL que hemos puesto en el Response.Redirect

(figura 57).

Figura 56. Ejecucion de un WebForm

x 33| Eoebughu | Q] & =| & =] 23| Wr -] G- & - =
B v B - i v Pagew Seeyr Took+ @+ 33 50 W O 5

I 1w -
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Figura 57. Ejecucién de un WebForm

-
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G Instala Google Chrome

(T
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®100% v

Este ejemplo nos puede servir para hacer redireccionamiento entre las paginas
de nuestro sitio y asi poder navegar entre ellas.

4.6. El ViewState

En una aplicacién de escritorio de Windows, una parte de la memoria del or-
denador es utilizada para almacenar el estado de la misma. En una aplicacién
web, el funcionamiento es totalmente diferente. Un cliente se conecta al ser-
vidor web, solicita una pagina y la conexion finaliza cuando la pagina se en-
trega, y se descartan todos los objetos que haya en memoria. Por esta razén,
surge el problema del almacenamiento de cierta informacion del estado de la
aplicacion entre diferentes peticiones de un cliente.

Una de las maneras de almacenar esta informacion en ASP.NET es hacerlo en
el ViewState. ASP.NET inserta automaticamente el ViewState como un campo
oculto en cada renderizacion HTML de una pagina. De esta forma se conservan
los datos entre diversas peticiones de servidor.

A continuacion (figuras 58, 59 y 60) podemos ver un ejemplo de un contador
que almacena las veces que un usuario pulsa un botén.
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Figura 58. Cédigo .cs de un ViewState

| dlient Objects & Events | (No Events)
¥ Page Language="C&" AutoEventWireup="true” CodeBehind="NuevolWebForm.aspx.cs™
Inherits="Nuevaiplicacidnieb.NuevokebForm™ %>

<IDOCTYPE html PUBLIC "=//W3C//DTD XHTML 1.8 Transitional//EN"
"hittp:/Sew w3 org/ TR/ xhtml1/DTD/ xhtmll-transitional . dtd">
Fl<html xmlns="http:/ /www.w3.org/1999/xhtml">
=l<head runat="server®:
<titler</ritles
< heads
=l <body >
= <form id="forml® runat="server"»
=] <div>
<asp:lLabel ID="Labell™ runat="server" />
<asp:Button ID="Buttenl®” runat="server"” Text="Button”/:
<fdivy
| < fform>
| </body>
</html>

0o%e - + 1

Figura 59. Cédigo . cs de un ViewState

MuevoWebForm.aspiees

“§ NuevaAplicaciénWeb.NuevoWebForm -] ¥ Pac
[Fusing System;
using System.Collections.Generic;

[Fnamespace Nuevahplicacidnieb

{
= public partial class NuevokebForm : System.Web.UI.Page
{
= protected void Page Load(object sender, Eventirgs e)
i
if (ViewState["contador™] == null)
i
ViewState["contader™] = @;
3
else
{
ViewState["contader™] = (int)viewState["contador”] + 1;
Labell.Text = ViewState["contador"].ToString();
X

100 % - 4
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Figura 60. Ejecucién de un ViewState
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4.7. Controles de servidor

ASPNET introdujo hace varios afios un modelo innovador para la creacién
de péaginas web. Anteriormente, para el disefio de paginas web dindmicas se
introducian etiquetas en el propio fichero HTML y, segtin la interpretacion de
estas etiquetas, se producia una salida de HTML u otro. Esta técnica, ademaés

de resultar tediosa, producia un c6digo poco extensible y reaprovechable.

ASP.NET solvento este problema introduciendo el concepto de controles de ser-
vidor.

Los controles de servidor se crean y se configuran como objetos. Una
vez configurados por el desarrollador, generan automaticamente su pro-
pio codigo HTML.

Algunas caracteristicas de los controles de servidor son:

e Generan su propia interfaz de usuario. Se genera el codigo HTML en tiem-
po de ejecucién y se envia al cliente.

e Retienen su estado. Guardan informacién de si mismos entre diferentes
peticiones.

¢ Disponen de eventos de servidor. Por ejemplo, un botén puede ejecutar
una funcién de servidor al ser pulsado.

ASP.NET ofrece una gran cantidad de controles de servidor que se pueden cla-
sificar en diferentes grupos. Todos ellos los encontraremos en el Toolbox de
Visual Studio. Alguno de los grupos mas importantes son:
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a) Controles de servidor HTML: grupo donde encontramos los elementos
HTML estdndares como los enlaces (<a>), los inputs (<input>), etc. Para con-
vertir un elemento HTML estandar en un control de servidor, inicamente de-

bemos indicar el atributo runat=server.

b) Controles web: controles con las mismas funcionalidades que algunos ele-
mentos HTML, pero que disponen de propiedades y métodos que facilitan su
declaracién y acceso. Algunos ejemplos son el Hiperlink, ListBox, Button, etc.

¢) Controles Rich: controles que amplian las funcionalidades de los elementos
HTML e incluso son capaces de generar codigo JavaScript propio. Un ejemplo
es el TreeView.

d) Controles de validacion: controles que permiten aplicar normas o reglas a
las entradas de datos de los usuarios.

e) Controles de datos: controles disefiados para mostrar grandes cantidades de
datos y para la edicién, ordenacién y paginacién de los mismos. El ejemplo
mas claro es el control GridView.

f) ASP.NET Ajax Controls: estos controles permiten al programador utilizar
la tecnologia AJAX sin necesidad de escribir c6digo JavaScript en el lado del

cliente.

4.7.1. Controles de servidor HTML

Como hemos dicho, los controles HTML son exactamente iguales que los ele-
mentos HTML comunes. Podemos encontrar todos estos controles en el Tool-
box, dentro del apartado HTML (figura 61).

Si arrastramos cualquier control HTML y lo soltamos en el disefiador de pé-
ginas veremos como automaticamente se genera el cédigo HTML correspon-
diente.

Toolbox

> Reporting -
4 HTML

X

(oA

1 B (B

oo}

|

4 General

There are no usable controls in this
group. Drag an item onto this text to

vyOXxX

Pointer

Input (Button)
Input (Reset)
Input (Submit)
Input (Text)
Input (File)

Input (Password)
Input (Checkbox)
Input (Radio)
Input (Hidden)
Textarea

Table

m

Image

Select
Horizontal Rule
Div

add it to the toolbox.

Figura 61. Controles HTML
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Figura 62. Cédigo .aspx de un control html

| Glient Objects & Events -
<%@ Page Language="C#" AutoEventWireup="true” CodeBehind="HuewvonebForm.aspx.cs”
Inherits="NuevaApphieb. NuevoklebFore™ X>

<IDOCTYPE html PUBLIC ~-//W3C//DTD XHTML 1.8 Transiticnal//EN"
“http: /S w3 org/ TR xhitell /DTO xhtmll -transiticnal . dtd"™ >

=dhtml xmlns="http: /S vwew.wd. org 1999 whiml ™ >
=<head runat="server”?
<titler<Stitle»
< head>
= <body>
= <form id="forml” runat="server®:
= <dive
<input id="Textl" type=T"text" /»
<fdivy
</form»
</body>
| <html>

W% - ¢

Para convertir el elemento HTML en un control de servidor, iinicamente te-

nemos que afiadir el atributo runat = server.

Figura 63. Cédigo . aspx de un control html

| Client Objects & Events | e
<%@ Page Language="C#" AutcEventWireup="true” CodeBehind="HuevoWebForm.aspx.cs”
Inherits="NuevaAppkeb.NuevokebFora™ >

<IDOCTYPE html PUBLIC =-//W3C//DTD XHTHML 1.8 Transiticnal//EN"
“http: S S w3 . org/ TR xhitell /DTD xhtmll-transitional . dtd™ >

Hihtml xmlns="http: /v wd . org 1998/ xhiml ">
Hihead runat="server”y
<titler<Stitle»
<fhead>
=<body>
= <form id="forml™ runat="server":
B <dive
| Binput id="Text1" type=“"text” runat="server=/§
< fdive
</form»
</bady>
| </html>

100 % = 4

Desde este momento podremos acceder desde el archivo de cédigo (. cs) me-

diante su id y modificar sus propiedades.



CC-BY-SA » PID_00194034 61

Introduccién a ASP.NET

Figura 64. Cédigo . cs de un control html

NuevoWebFormeaspr.cs™ > JUIITRERTR T Default.aspx

%5 MuevahppWeb NueveWebFam -[ ¥Pag

—lusing System;

-|namespace NuevaAppheb

{
public partial class MuevckiebForm t Page
{
protected void Page Load(object sender, enthArgs e)
{
Textl.Visible = false;
H
}
}

0% - 4

Si ejecutamos la aplicacién, podremos ver que nuestro elemento no es visible,
ya que hemos aplicado la propiedad Visible = false.

4.7.2. Controles web

Los controles de servidor HTML proporcionan una forma relativamente rapida
de migrar html a ASP.NET, pero no es necesariamente la mejor. Por un lado, los
controles HTML y sus atributos no siempre tienen unos nombres intuitivos, y
tareas como estilar el control pueden resultar tediosas.

Para resolver estos problemas, ASP.NET pone a nuestra disposicion los contro-
les web que basicamente generan el mismo HTML que los controles de servi-
dor HTML, pero disponen de una configuracién mucho mas sencilla.



CC-BY-SA » PID_00194034 62 Introduccién a ASP.NET

Los controles web estan disponibles en el Toolbox dentro del apartado Standard Toolbox .
(figura 65) 4 Standard =
R Pointer
9 AdRotator
Si arrastramos, por ejemplo, el control web Button y lo soltamos en el editor z“l':‘ed““
utton
de codigo, veremos que, como con los controles HTML, se genera un bloque B2 Calendar
de cédigo por defecto. CheckBox
s= CheckBoxList
&3 DropDownlList
Figura 66. Codigo . aspx de un control web T, FileUpload
: bl HiddenField
(T - - 3L i A Hyperlink
«X@ Page Langu::ge-'t#" AutoEventiWireup="true” CodeBehind="NuevchebForm.aspx.cs” & Image =
Inherits="Nuevaippkeb.NuevokiebFora™ %>
ImageButton
<IDOCTYPE html PUBLIC ~-//W3C//DTD XHTHL 1.8 Transitional//En" §  ImageMap
“http: /Swew. w3 . org/ TR/ xhtell /OTO xhtmll-transitional .dtd™ > A Label
=¢html xmlns="http:/Swew. wd. org 1999 xhiml "> LinkButton
= ¢head l_'umr-"sv._'.nrl:r':- =8  ListBox
<,rh:;:1t1“dutlt? B Literal
= <body> %l Localize
= ¢form id="forml" runat="serwver™: @ MultiView
3 adivr 1 Panel
i gasp:Button ID="Buttonl™ runat="server” Text="Button™ .l')l —
<fdivy <1 PlaceHolder L)
<[ farm> ® RadioButton
</body> 2= RadioButtonList
</heal> ia) Substitution
[ Table
[abl  TextBox
O View
% Wizard
E  Xml
1> Data =
0% « 4 Figura 65. Controles web

Si modificamos una de las propiedades, por ejemplo Height, y ejecutamos
el sitio web, veremos como automaticamente se aplica el valor que hemos
indicado a la altura del botén.
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Figura 67. Cédigo . cs de un control web

I Client Objects & Events 'I (Mo Ever
<X§ Page Language="C#" AutoEventWireup="true” CodeBehind="NuevokebForm.aspx.cs”
Inherits="NuevaApphieb.NuevoklebFora™ X

<IDOCTYPE html PUBLIC ==/ W3C//DTD XHTML 1.8 Transiticnal/SfEN"
“hitp: /S wew. w3 . org/ TR xhitml1/DTD xhtmll -transiticnal . dtd" >

=ahtml smlns="http:/ wew. wd.org/ 1998/ vhtml™>
=<head runat="server”>
<titler</title>
<fheads
=<body>
= ¢form id="forml® runat="server®:
B <div>
Eazp:Button ID="Buttonl™ runat="server” Text="Button® Height="10a"/§
< fdiv>
</ form>
</bady>
L < heml>

Wi% = ¢

Figura 68. Ejecucién del ejemplo de un control web

— - _ - e e=aa=y

@@ @ http://localhost4178/NuevoWebForm.aspx P-ReX| {n vy et
@ localhost x

x 88+ | (B DebugBar ®~| | @& v| 2 ~| 53v| 100% ~ e n la pagina -

=~ v [ e v Pagev Safetyv Tools~ @~ 33 N M O

|
Button
©100% ~

Como hemos podido observar, en el ejemplo de los controles web podemos
acceder a las propiedades desde el disefiador de paginas, mientras que en el
ejemplo de los controles HTML lo haciamos desde el archivo adjunto .cs. Esta
es otra de las ventajas de utilizar los controles web en lugar de los controles
HTML.
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4.7.3. Controles Rich

Los controles Rich o Rich controls nos aportan complejas interfaces de usuario.
Estos controles nos ofrecen funcionalidades mucho més amplias que los con-
troles HTML o web. En realidad cada control Rich es un conjunto de contro-
les web que utilizamos como uno solo. El ejemplo mas claro es el del control
Calendar que esta compuesto por Buttons, Labels o Hyperlinks.

Los controles Rich los encontramos en el apartado Standard del Toolbox. Con-

cretamente algunos de los controles Rich mas importantes son:

e (Calendar: calendario que permite navegar entre meses, dias o afios.

e Multiview y View: permite implementar diferentes vistas en una misma

pagina y navegar entre ellas.

e AdRotator: banner para mostrar una serie de imagenes.

De nuevo arrastraremos un control de este tipo, concretamente un Calendar,
y lo soltaremos en el disefiador. Vemos que, aunque internamente estd com-
puesto por varios controles web, inicamente se genera una etiqueta Calendar
(figura 69). Hacemos lo mismo con un control web Label, que nos servira para

mostrar el dia seleccionado.

Figura 69. Cédigo .aspx de un control Rich

I Client Dbjects & Events - (Mo Event:
<X@ Page Language="C#" AutoEventWireup="true” CodeBehind="HuevowWebForm.aspx.cs”
Inherits="Nuevasppleb. NuevokebFore™ 3>

<IDOCTYPE hitml PUBLIC =/ W3CS/DTD XHTML 1.8 Transitional//EN"
“hitp:s e wd . org/ TR/ xhtell /D70 xhtmll-transitional. . dtd" >

<html xmlns="http:/ wi.w3.org/ 1999/ xhtml ">

Zhead runat="server™s
<titlex</title>
< heads>
= <body»
<form id="forml” runat="server”:
<dive
<mspiCalendar ID="Calendarl™ runst="server”s</asp:Calendars
<asp:Label ID="Labell* runat="server” Text="Label"»</fasp:Label>
<fdive
</ farmy
< fbady >
</htmls

% - ¢

Al igual que los controles web, podemos modificar propiedades o afiadir even-
tos tanto desde el disefiador como desde el archivo adjunto .cs.



CC-BY-SA » PID_00194034 65

Introduccién a ASP.NET

A continuacién, en el disefiador, en la ventana de propiedades desde el apar-
tado de eventos hacemos doble clic sobre el evento SelectionChanged. Esto

nos generard automaticamente un evento que se disparara al cambiar el dia
seleccionado.

Figura 70. Ventana de propiedades del control

Properties yAax
Calendarl System.Web.ULWebControls.Calendar -
oz 2l 7 (IS

4

DayRender

SelectionChanged Calendar1_SelectionChanged |Z|

VisibleMonthChanged

DataBinding

Auto Format...

SelectionChanged
Fires when selection is changed by the user.

Dentro de la funcién SselectionChanged escribimos el cédigo que nos actua-
lizara el control web Label con la fecha seleccionada.

Figura 71. Cédigo . cs de un control Rich

Musvo\WebForm.aspoes® 0 T

I ij ‘J-Ja_-.g.kpp.‘.'cb MueveWebForm .-l ?U(glcn'_‘le
=using System;

- namespace Nuevaippiiel

i
public partial class HuevoWebForm @ System.wWeb.UL.Page
{
protected void Page Lead(cbject sender, Eventhrgs e)
{
I
= protected void Calendarl SelectionChanged(cbject sender, Eventirgs &)
Labell.Text = Calendarl.SelectedDate.ToString();
¥
¥
B

0% - 4
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Ejecutamos y comprobamos que mientras vamos cambiando la seleccion, la
etiqueta se va actualizando correctamente.

Figura 72. Ejecucién del ejemplo de un control Rich
&= HY¥il«a D B g -

@ localhost
X 83| (B DebugBar @~ | (3| (@ | & ~v| sav]| 100%
o~ v [ @ v Pagev Safetyv Toosv @~ §3 N

< noviembre de 2011 >
lun mar mié jue vie

31

5
o B
o
g
(=
B

100 1
IS
I

O
=}

[ 131

1o o [ |5 2 e

o 632 [ |
=813 & re s
121
51 813 |
2
3

Slioo 1—

6 7
011 0:00:0

[~
o

1/

[~

®100% ~

4.7.4. Controles de validacion

Una de las funcionalidades mas comunes de las paginas web es recoger datos
insertados por los usuarios. A menudo una pagina web pide datos a un usuario,
que finalmente serdn guardados en una base de datos. En la mayoria de casos
estos datos deben ser validados para asegurar que no se almacena informacién
incoherente. Idealmente, el dato entrado por el usuario debe ser validado en
cliente, mediante JavaScript, y en servidor, en nuestro caso mediante ASP.NET.

Para no tener que escribir el codigo de validacién manualmente, que seria una
tarea bastante laboriosa, ASP.NET dispone de seis controles de validacion:

¢ RequiredFieldvalidator: chequea si el control relacionado esta vacio

cuando se envia el formulario.

e RangeValidator: comprueba que la entrada del usuario esté dentro de

un determinado rango.

e CompareValidator: chequea que el valor del control cumpla una deter-

minada condicién (mayor que, menor que, igual a).

¢ RegularExpressionValidator:comprueba que el valor de un determi-

nado control cumpla una expresion regular.

* CustomValidator:permite al desarrollador especificar una funcion clien-

te y una de servidor, que validaran la entrada del usuario.
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* ValidationSummary: proporciona unaregion con los errores de todos los

validadores de la pagina.

Estos controles realizan la mayor parte del trabajo y el programador solo tiene
que configurarlos para su correcto funcionamiento. Podemos encontrar todos
estos controles en el Toolbox dentro de la seccion Validation (figura 73).

Para probar como funciona un control de validacién, primero debemos inser-
tar el control en la pagina, asi que arrastraremos un TextBox desde el Toolbox

hasta el editor.

Figura 74. Cédigo . aspx de un control de validacion

| Client Objects & Events N T
%@ Page Language="C#" AutoEventhireup="true” CodeBehind="NuevoWebForm.aspx.cs”
Inherits="NuevaAppkeb.NuevokiebFora™ %>

<IDOCTYPE html PUBLIC ~-//W3C//DTD XHTML 1.8 Transitional//EN"
“http: /e w3 orgd TR xhitel1/0T0 xhtmll-transiticnal . dtd™>

chtml xmlns="http://wew.w3.org/1999/xhtel" >
¢head runats"server™>
<titler</title>
</head>
= <bady>
<form id="forml™ runats="server”:
Ldive
gasp:TextBox ID="TextBoxl" runat="server”»</asp:TextBoZ
<fdiv>
< fform>
</ bady >
</html>

W% -

A continuacio6n arrastramos el control de validacion que queramos aplicar, por
ejemplo, un RangeValidator, y configuramos los siguientes atributos:

e FErrorMessage: error que aparecera cuando la validacion falle.

¢ MaximumValue: valor maximo que se puede introducir.

¢ MinimumValue: valor minimo que se puede introducir.

e ControlToValidate:ID del control sobre el cual se aplicara la validacion.

Por altimo arrastramos un Button a nuestra pagina, con el cual realizaremos

el envio del formulario.

Toolbox =P
»> Standard

i Data

4 Validation

Pointer

L 4

&

CompareValidator

CustomValidator

(IH

G &4

RangeValidator
RegularExpressionValidator
RequiredFieldValidator
ValidationSummary

> Navigation

> Login

> WebParts

> AJAX Extensions

> Dynamic Data

> HTML

4 General

There are no usable controls in
this group. Drag an item onto
this text to add it to the toolbox.

Figura 73. Controles de validacion
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Figura 75. Cédigo .aspx de un control de validacién

| Giient Objects & Events =] (Mo Events)
«X@ Page Language="C#" AutoEventiWireup="true” CodeBehind="NuevowebForm.aspx.cs™
Inherits="NuevaAppieb.NuevokebFora™ X>

<IDOCTYPE html PUBLIC =-//W3C//DTD XHTHL 1.8 Transiticnall/EN"
“http:/ S, w3 org/ TR/ xhtell /DTO/ <htmll-transiticnal . dtd">

=<html xmlns="http://wew.wd.org/ 1995/ xhtml">
=<head runat="server™»
<titler</title>
</head>
= <bady>
= <form id="forml® runat="server™>
- <divy
casp:TextBox ID="TextBoxl" runst="server”»¢ /asp:TextBox>
<aspiRangevalidator ID="Rangevalidatorl™ runat="server” Errortessages"El valor estd fuera de los limites®
MaximesValue="58" Minimumvalue="18" ControlToValidate="TextBoxl"»</asp:RangeValidators
casp:Button ID="Buttonl™ runat="server” Text="Butten™ />
<fdivs
</form>
< /body>
< /html>

% -

Si ejecutamos nuestra pagina e introducimos valores en el TextBox, veremos
como nos aparece el mensaje “El valor estd fuera de los limites” cuando en-

viamos el formulario con un valor erréneo.

Figura 76. Ejecucién del ejemplo de un control de validacién

@@ @ http://localhost:4178/NuevoWebForm.aspx
@ localhost »

x 88| (Bl DebugBar @~ | @ @ ~| & ~| S| 100%
B v B v ) @ v Pagev Safetyv Toosv @~ $3 N [

9 El valor esta fuera de los limites

®100% ~

4.7.5. Controles de datos

Los controles de datos nos permiten mostrar grandes cantidades de datos con
soporte de caracteristicas de alto nivel, como ordenacién, paginacion, etc. El
control por excelencia y mas utilizado de este grupo es el GridView.

Este control es extremadamente flexible y nos muestra los datos en forma de
filas y columnas. Con este control se cubren las funcionalidades mas comunes
con el manejo de datos, como son la paginacién, la ordenacion o la selecciéon
de elementos.
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Ejemplo practico de uso del GridView

Para saber mejor cémo funciona el GridView, veremos un pequerio ejemplo practico.

Al igual que los demas controles, encontraremos el GridView disponible en el Toolbox
(figura 77). Arrastramos un GridView al editor y vemos como automaticamente genera

el c6digo xml.

Figura 78. Cédigo .aspx de un control de datos

[ client Objects & Events <] (No Events)
<¥@ Page Language="C#" AutoEventWireup="true" CodeBehind="NuevoWebForm.aspx.cs"
Inherits="NuevaAppWeb.NuevollebForm" %>

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.@ Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtmll-transitional.dtd">
=I<html xmlns="http://www.w3.0rg/1999/xhtml">
-I<head runat="server">
<title></title>
</head>
=1<body>
] <form id="forml" runat="server">
B <div>
<asp:GridView ID="GridViewl" runat="server">
</asp:Gridview>
@ </divi]
</form>
</body>
</html>

100% ~ ¢

A continuacién debemos proporcionar el origen de los datos al control. La forma mas
sencilla es construir una lista de objetos, asi que creamos una clase llamada Persona.

Figura 79. Ejemplo de un GridView

O
Solution Explorer |4} View in Browser
=l Convert to Web Application
N (2] 5y PP!
3 Solution ‘Nuevaap| @&  Check Accessibility..
4 *-3 NuevaAppWet Calculate Code Metrics
> [=4 Properties
[:3] References KB Run Pex
[ Account Pex »
E“ :P'."tD ot Add v [ & Newtem.. CtrlShift+ A
cripts
3 Styles Add Reference... (2] Existing Item... Shift+Alt+A
b [Z] About.aspx Add Service Reference... 4 New Folder
b Z] Default.aspy Add Deployable Dependencies... Add ASP.NET Folder »
4] Global.asax Add Library Package Reference... New from Template »
[Z] NuevoWebf ) .
[ Site Master | &% |_View Class Diagram %% Class.. Shift+Alt+C
3 Web.config Set as StartUp Project
Use IIS Express...
Debug >
(2% Add Solution to Source Control...
% Cut Ctrl+X
24 Paste Ctrl+V
X Remove Del
Rename

b Standard
4 Data
R Pointer
[ AccessDataSource
il Chart
&) Datalist
42»  DataPager
‘_,j DetailsView
4  EntityDataSource
‘_;l FormView
A GridView
&) LingDataSource
] ListView
% ObjectDataSource
E5  Repeater

100

5§ QueryExtender
':}h SiteMapDataSource
[ SqlDataSource
{,‘,, XmlDataSource
b Validation
> Navigation

m

=

Figura 77. Controles de datos
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Figura 80. Ejemplo de un GridView

Installed Templates Search Installed Templates £
4 Visual 2 .
Code Pex Class for VSTS Visual C# Type: Visual G
Dote An empty class declaration
General Web Form Visual G|
Web
Windows Forms Web Form using Master Page Visual C#
weF
Reporting Web User Control Visual G2
Silverlight .
Workflow ch] class Visual C#
Online Templates
Master Page Visual C#
Nested Master Page Visual C2
L.j HTML Page Visual G2
Al style Sheet Visual C#
& Iscript File Visual C#
B .
o] Interface Visual G
|
éﬁ ADO.NET Entity Data Model Visual C#
43, ADO.NET EntityObject Generator Visual G2~
Name: Persona.cs
Add Cancel

Figura 81. Ejemplo de un GridView

Person: oWebFor

B NuevoWebForm.asp
% NuevaAppWeb.Persona [ 2edad

Team Explorer

[-Inamespace NuevaAppWeb

B public class Persona

{
public string Nombre { get; set; }
public int Edad { get; set; }
}
¥
100% ~ ¢

A continuacién, en el evento Page Load del archivo . cs generamos una lista de objetos
Persona.

Figura 82. Ejemplo de un GridView

[ “t NuevaAppWeb.NuevoWebForm
-lusing System;

¥ Page_Load(object sender, EventArgs €)

“Inamespace NuevaAppieb

{

5 public partial class NuevolebForm : Sy

Web.UI.Page
2 protected void Page_Load(object sender, EventArgs e)

List<Persona> listaPersonas = new List<Persona>();
Persona primera = new Persona();

primera.Nombre =
primera.Edad = 13;

Persona segunda = new Persona();
segunda.Nombre
segunda.Edad = 13;
listaPersonas.Add(primera);
listaPersonas.Add(segunda);

100% ~ ¢
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Finalmente, relacionamos la lista anterior creada con el origen de datos o DataSource
del GridView.
Figura 83. Ejemplo de un GridView

NuevoWebForm.aspx.cs X [NTEHAUEI I EHOY

4 NuevaAppWeb.NuevoWebForm [ 3% Page_Load(object sender, EventArgs €)

-lusing System;
using System.Collections.Generic;

-Inamespace NuevaAppheb
public partial class NuevolWebForm : System.Web.UI.Page

protected void Page_Load(object sender, Ev

List<Persona> listaPersonas = new List<Persona
Persona primera = new Persona();
primera.Nombre = "Juan";

primera.Edad = 13;

Persona segunda = new Persona();
segunda.Nombre = "Juan";

segunda.Edad = 13;

1listaPersonas.Add(primera);
1listaPersonas.Add(segunda) ;

Gridviewl.DataSource = listaPersonas;
Gridviewl.DataBind();
}
}
}

100% ~ ¢

Si ejecutamos nuestro web site podemos ver como autométicamente se crea una Grid,
donde las columnas son las propiedades de la clase Persona y las filas corresponden a
cada uno de los objetos de la lista.

Figura 84. Ejemplo de una GridView
L TR 20000 e O o o

(\J@ @ hitp://localhost:4178; NuevoWebForm aspx
@ localhost x
x 88| (Bl DebugBar @~ | | @ ~| 2 ~
% v B v @ v Pagev Safetyv Toolsv @~ 33 N M @ i

S5~ | 100%

Nombre|Edad
Juan 13
Juan 13

®100% ~

4.8. Controles de usuario

Una aplicacién web bien construida divide el c6digo en diferentes bloques
independientes. Cuanto mas modular es la aplicacién, maés facil es mantener
su codigo, solucionar errores y reutilizar componentes. Para la organizacion
del c6digo en diferentes componentes, ASP.NET pone a disposicion del desa-
rrollador los UserControl o controles de usuario. Los UserControl se parecen
mucho a los WebForm, ya que estdn compuestos por una porcion de cédigo
con etiquetas HTML y controles de servidor (el archivo .ascx) y un archivo
de coédigo con la logica y los eventos.

Las tnicas diferencias entre los UserControl y los WebForm sén:
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a) Los UserControl utilizan la extensién .ascx en lugar de .aspx y la clase
del c6digo . cs hereda de UserControl en lugar de Page.

b) El archivo .ascx comienza con la directiva <$@Control%> en lugar de <

$@Page%>.

c) Los UserControl no pueden ser solicitados directamente por un navegador.
Siempre deben estar embebidos dentro de un WebForm.

4.8.1. Creando un UserControl

La manera de crear un UserControl en Visual Studio es muy similar a la forma
de crear un WebForm. Debemos seleccionar Add > New item y escoger Web User
Control de la lista. Le damos el nombre de, por ejemplo, NuevoControl.ascx.

Figura 85. Creando un UserControl

Solution Explorer A= ¢
==l
(A NuevaAplicacion
=4 MyPr £ Build
> [ Accoy Rebuild
5 App L
[ Script
. &3 SMZS 5 Build Deployment Package
=] Abou! ¥ Publish...
=] Defau &3 Package/Publish Settings

Clean

i s

] G1ob3 (& View in Browser Ctrl Shift+W
g \Sllv‘:bh: Convert to Web Application
Add * | ] Newltem... Ctrl+Shift+A
Add Reference... [ Existing Item... Shift+Alt+A
Add Service Reference... 4 New Folder
Add Deployable Dependencies... Add ASP.NET Folder »
Use IIS Express... ] Module...
Debug > | % Class..
Cut Ctrl+X
A  Paste Ctrl+V
Rename
[2 Properties Alt+Enter

] Solution Explorer [EENMEEE 03
Add New Item |

Installed Templates Sort by: i [ search Installed Templates »|
4 Visual Basic - 7 . .
Code Web Form Visual Basic Type: Visual Basic
o An ASP.NET server control created using
ata the visual designer
General Z-=| Web Form using Master Page Visual Basic
Web
Silverlight d=| Web User Control Visual Basic
Online Templates Web User Control
"Bﬂ Class (WebUserControl} ' pagic g
Master Page Visual Basic
Nested Master Page Visual Basic
\ﬂ HTML Page Visual Basic
rﬁ Style Sheet Visual Basic
5| Jscript File Visual Basic
Ve & AJAX-enabled WCF Service Visual Basic
\_gj ASP.NET Handler Visual Basic
g ASP.NET Module Visual Basic
T4 ASP.NET Server Control Visual Basic  ~
Name: NuevojWebUserControl.ascx
e

Modificamos el archivo .ascx para que quede de la siguiente forma:
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Figura 86. Cédigo . aspx de un UserControl

[ Chent Obpects & Events = M Evenis)
<& Control Languages="C8" Autofventilresp="true” CodeBehind="NuevonebUserfontrol.ason.cs”
Inherits="Huevasplicac Linkeb . NusvokeblserContral™ X

<atpilabel ID="1b1PiePagine” runat=server” [

En el archivo de c6digo relacionado vemos cémo los eventos son muy pareci-
dos a los de los WebForm. Modificamos también este archivo para que quede
de la siguiente manera:

Figura 87. Cédigo . cs de un UserControl

MuevaWebUserContralascrcs 3 JRIERLEAE I 20 e Fon cs Muevo'WebForn
4 NuevasplicaciinWeb NusvoWebUserContro -I ¢ Page_Loa
Susing System;
-namespace Nuevadplicacidnideb
L]
= public partial class BuewvowebUserControl @ System.Web.UI.UserControl
{
protected void Page Lead{object sender, Eventirgs )
lblPiePagina. Text = "Pie de pigina.™;
}
" }
W% = 4

Para poder probar este UserControl es necesario insertarlo en un WebForm.
Se trata de un proceso de dos pasos. En primer lugar necesitamos agregar la
directiva Register a la pagina que contendré el UserControl justo después
de la directiva page.

<%@ Page Language = "C#" AutoEventWireup = "true" CodeBehind = "NuevoWebForm.aspx.cs"
Inherits = "NuevaAplicacionWeb.NuevoWebForm" %>

<%@ Register TagPrefix = "customControls" TagName = "pie" Src = "NuevoWebUserControl.ascx" %>
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En esta directiva, como podemos ver, se debe especificar un prefijo y un nom-
bre. La directiva Src sirve para informar de la localizacién del UserControl.

A continuacién debemos insertar el UserControl en el WebForm como si fuera
un control de servidor mas mediante la siguiente directiva, especificando el
prefijo y el nombre:

<div>
<customControls:pie runat = "server"></customControls:pie>

</div>

Si ejecutamos la pagina podremos ver como el UserControl se muestra como

si fuera un control mas (figura 88).

Figura 88. Ejecucion del ejemplo del UserControl

2¥L0:50 .

3 P -
2
(K @ nitp:/Nocalnost6976/NuevoWebFormaspe

& localhost x — e
x 88~ | Eoebugtar &~ | Q| @& | £2 ~| 2i-[00x -] &
) v B v = @ v Pagev Safetyv Tooksv @~ §3 N B ) i

Body
Pie de pagina.

®100% ~

4.9. Paginas maestras

Cuando diseflamos un sitio web, normalmente disponemos de una serie de
elementos comunes en todas las paginas: el logotipo de la organizacién, un

pie con informacion, una serie de enlaces generales, etc.

Una novedad que introdujo ASP.NET son las paginas maestras. Gracias a estas
se reduce el tiempo de disefio y el mantenimiento del sitio.

Una pagina maestra es una combinacion de c6digo HTML y controles
de servidor, como cualquier otra pagina de ASP.NET, con la peculiaridad
de que se almacena en un archivo con extension .master en lugar de

la habitual extensién . aspx.
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Otra diferencia respecto a los WebForm se centra en la cabecera del archivo

.master.

En una pagina maestra, la directiva Page es sustituida por la directiva Master.

<%@ Master Language = "C#" AutoEventRireup = "true" CodeBehind = "Sitel.master.
Inherits = "NuevaAppWeb.Sitel" %>

Como hemos dicho, en una péagina maestra podemos introducir contenido
HTML, componentes de servidor y cualquier otro contenido que pueda exis-
tir en una pagina ASP.NET. Lo que distinguira a la pagina maestra de otras es
la aparicion como parte del contenido de uno o mas componentes Content-
PlaceHolder.

Figura 89. Cddigo .aspx de una pagina maestra

| Client Objects & Events = iNo Events)
5@ Master La " At spthlreup="troe” Code nd="Sitel.master.cs”
Inherits="Nuevadpphieb.Sitel™ X

<IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8 Transzitienal//EN"
“hetp: S Seww w3 or g TR xhtell /DTD chtmll-transitional . dtd™ >

=<html xmlns="http:/ www. w3 . org/1995 xhiml™»
<head runat="server®>
<titlex</title
<aspiContentPlaceHolder ID="head” runat="server”:
<fasp:ContentPlacetolders
</head>
= <body»
«form ids"forml®™ runat="server™>
“divy
<asp:ContentPlaceHolder ID="ContentPlaceHolderl™ runat="server™>
<fasp:ContentPlacetolders
<fdivy»
</ fora:
< /body >
</html

4.9.1. Componentes ContentPlaceHolder y Content

Al diseflar una pagina maestra iremos dejando unos huecos o contenedores,
representados por componentes ContentPlaceHolder. Después, en cada pa-
gina individual se introducira el contenido especifico aportado por los com-
ponentes Content.

El componente ContentPlaceHolder, por tanto, aparecerd en el archivo
.master. La propiedad que mas nos interesa de este componente es el ID, a
la que asignaremos un identificador o nombre que sera el que sirva para enla-
zarlo con el control Content.

cs
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Figura 90. Cédigo .aspx de una pagina maestra

| Client Objects & Events =| (Mo Events)
€% Master Language="Ci" AutoEventWireup=“true” CodeSehind="Sitel.master.cs”
Inherits="Nuevafppieb,5itel” X
<IDOCTYPE html PUBLIC -/ W3C//DTD MHTML 1.8 Transzitional//SEN"
“http: S S wd . org TR xhiall /DTD xhimli-transitionsl .. ded™>
=<html wmlns="http: /v wd.org/1959 xhtml™>
chead runats"server™s
ctitler</titles
<asp:ContentPlaceHolder ID="head” runat="server®:
«/aspiContentPlaceHalder»
< head>
- cbody >
= <form ide"forml™ runate™server™>
adivy
<asp:ContentPlaceHolder ID="ContentPlaceHolderl™ runat="server™>
<fasp:ContentPlaceHolders
ofdive
«/farm>
< body>
</html>
% -
Figura 91. Cédigo . aspx de una pégina de contenido
| Client Objects & Events - iNe Events)

Page Language="CR" AutoEventWireup="true” CodeBehind=“HuevoWebFarm.aspx.cs™
B Buag B
Inheritse"Huevaipphieb. NusvoliebForm™ MasterPageFile="r/Sitel. Haster“Xs

—l<asp:lontent ID="ContentHead” ContentPlaceHolderIDa“head™ runat="serwver™:
<fasprContents
<asp:Centent ID="Contentl™ ContentPlaceHolderID="CententPlacetolderl™ runat="server”:

<faspiContent>

Vemos que para referenciar la pAgina maestra en el WebForm especifico se uti-
liza la propiedad MasterPageFile, que aparece como atributo en la directiva
Page de aquellas paginas donde interese incluir el disefio base.

4.9.2. Ejemplo practico

Ahora que conocemos a grandes rasgos los elementos principales de las pagi-
nas maestras, podemos ver como utilizarlas en el disefio de un sitio sencillo.
Comenzaremos creando un nuevo proyecto web vacio. A continuacién abri-
mos el cuadro de dialogo Add > New itern con el botén derecho del ratén sobre
nuestro proyecto y seleccionamos Master Page (figura 92).
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Figura 92. Afadiendo plantilla de MasterPage

Add New Item -
Installed Templates Sortby: [ Search Installed Templates 2|
4 Visual C# = )
— 3 3
Code Web Form Visual C# Type: Visual C -
Dote A Master Page for Web Applications
General Web Form using Master Page Visual G
Web
Windows Forms H=) Web User Control Visual C#
WPF i
Reporting ch] Class Visual C# |
Silverlight —
Workflow D Master Page Visual C#
Online Templates
] Nested Master Page Visual G2
@ HTML Page Visual C#
AS] Style Sheet Visual C#
@ IScript File Visual C#
‘CRJIE AJAX-enabled WCF Service Visual C#
% ASP.NET Handler Visual C#
L‘:ﬂ ASP.NET Module Visual C# !
A ASP.NET Server Control Visual G~
Name: Sitel . Master
Add Cancel

Esta pagina maestra por defecto contendrd tinicamente un contenedor Con-
tentPlaceHolder.

Figura 93. Cédigo .aspx de una pagina maestra

| Client Objects & Events =| (Mo Event:
<@ Master Languages"C8" AutoEventiWlreup="true” Codefehind="Sitel.master.cs”
Inheritse"Nusvaiplicae idnkeb. Sitel™ ¥>

<IDOCTYPE html PUBLIC “-f/ W3C//DTD MHTML 1.8 Tranzitisnal//EN™
“http: S Swwn . wd . org TR/ xhtal1 /070 chitmll-transiticnal . dtd™ >

=<html xmlns="http:/ wew. wd. org 1999 xhtml™>
<head runat="server™>

ctitlesc/titles
« fhead s
- Ebady >
- «forn fde"forml™ runats”server™>
= adlivy

= <asp:ContentPlacedolder ID="ContentPlaceHolderl™ runats"server™>
<fasp:ContentPlaceHolder>
<fdivy
</ fore>
iy
</html>

Introducimos un contenido por defecto en el ContentPlaceHolder, que se
mostrara siempre y cuando no lo sobrescribamos con el componente Content
que veremos a continuacion, y agregamos los elementos propios de la padgina
maestra, como la cabecera o el pie.
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Figura 94. Cédigo . aspx de una pagina maestra

| Client Objects & Events | (NoEvents
<K@ Master Languages"C#" AutoEventWlireup="true® CodeBehind="Sitel.master.cs”
Inheritse“Nuevasplicacidnbeb, Sitel” X2

<IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Tranzitional//EN"
"http: f fein w3 org/ TR/ xhtell/DTD/ xhtmll-transitional . dtd™ >

=<html xmlns="http:/ v wl_ org /1999 xhiml = >

=<head runat="server=>

ctitlesc/titles

< heads

- <body >

- oform ide"forml™ runat="server™>
ddiv:Cabecaras /divy

- adivy

= <asp:ContentPlaceHolder ID="ContentPlaccHolderl™ runat="server™>
Centenide por defecto
<faspiCantentPlacetolders
<fdivy
cdivePles/dive
<fformr
</body»
< htm]l >

100% = ¢

A continuacién abrimos otra vez el menu Add > New item'y seleccionamos Web
Forms using Master Page. Se abrird una ventana mostrando en la lista derecha
las paginas maestras disponibles. Elegimos la que acabamos de crear.

Figura 95. Afiadiendo plantilla de pagina de contenido

Add New Item - =

Installed Templates Sortby: [ search Installed Templates 2|
4 Visual C# - .
= 2 Type: Visual C#
Code S=| Web Form Visual C# ype: Visua
— Aform for Web Applications that is built
Data from a Master Page
General Web Form using Master Page Visual C#
Web - Web Form using Master Page |
Windows Forms H=| Web User Control
WPF 1
Reporting 0‘9 Class Visual C# |
Silverlight =
[ Workflow ] Mesterpage Visual C#
Online Templates
D Nested Master Page Visual C#
@ HTML Page Visual C#
A=l style Sheet Visual C#
GE|  Iscript File Visual C#
oF 5y AJAX-ensbled WCF Service Visual C#
g ASP.NET Handler Visual C#
-‘=3 ASP.NET Module Visual C#
Tﬂlf ASP.NET Server Control Visual C# <
Name: NuevolWebForm.aspx
Cancel
Select a Master Page (el x
Project folders: Contents of folder:
4 (2 NueveAplicacinWeb [l Sitel Master]

» (=4 Properties
» [« References
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Para cada pagina que afladamos al proyecto y que enlacemos a la pagina maes-
tra, tendremos que agregar un contenido en el correspondiente objeto Con-
tent. Para relacionar el componente Content con su correspondiente Con-
tentPlaceHolder, Gnicamente debemos indicar en el primero el 1D del se-
gundo.

Figura 96. Cédigo .aspx de una pagina de contenido

| Client Objects & Events -|  (NoEvents)
£58 Page Title="" Language="C#" HasterPageFlile="-~/5itel.Hazter™ AutoEventWireup="true®
CodeBehind="NuevokebFors, aspi. 4™ Inheritoe"NuevadplicacidaWel . HuevodebFaore™ X
Efp:content ID="Contentl™ ContentPlaceHolderID="ContentPlaceHalderl” runate*server*§
<fasp:lontent>

Introducimos el contenido que queremos que aparezca en el espacio del Con-
tentPlaceHolder.

Figura 97. Cddigo .aspx de una pagina de contenido

| Client Objects & Events -]  (NoEvents
<X Page Title="" Language="C#" HasterPageFile="~/Sitel.Master”™ AutebventWlreup="true”
Codefehinde "Husveklebfors. aspu. c2™ Inherits="Nusvadplicac idnieb . HusvobebFore™ X»
caspifantent ID="Contentl™ CanterntPlaceHolderID=“ContentPlaceHalderl” runate"server®:
Contenido especifico de HusvolebForn]
<fasprlontents

Con estos simples pasos ya tendremos una pagina accesible desde el navegador
con una cabecera, un contenido y un pie. Si ejecutamos la aplicacion, veremos
la pagina que hemos creado incluida dentro de la pagina maestra (figura 98).
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Figura 98. Ejecucién del ejemplo de MasterPage

& localhost X - L — e
"X 83+ | B Debugbar &~ | D] @ v| £ v| iiv| 0% | @~ &) v ®| Buscaren Googe | Destacaren la pagina -
R I v [ d v Pagev Safetyv Tookv @~ $3 &N M

Cabecera

Contenido especifico de NuevoWebForm
Pie

®100% v ||
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5. ASP.NET AJAX

En otros médulos hemos visto como implementar la técnica AJAX mediante
JavaScript, y mas concretamente mediante el objeto XMLHttpRequest que
existe en todos los navegadores actuales. Esta forma de construir peticiones
asincronas, como hemos visto, es bastante laboriosa e implica invertir mucho

tiempo de trabajo.

ASP.NET pone a disposicion del desarrollador ASP.NET AJAX para facilitar la
tarea de la implementacion AJAX en nuestros sitios web. ASP.NET AJAX consta
de dos partes principales: una parte del lado del cliente y una parte del lado
del servidor.

La parte del lado del cliente es un conjunto de bibliotecas JavaScript. Basica-
mente, estas bibliotecas afladen funcionalidades a JavaScript para facilitar el

desarrollo de nuestras aplicaciones.

La parte de servidor de ASP.NET AJAX, que es la que de verdad nos interesa,
funciona en un nivel superior. Incluye controles y componentes que utilizan
las bibliotecas JavaScript del lado del cliente sin que tengamos que tener co-
nocimiento de ellas.

5.1. El ScriptManager

El ScriptManager es el cerebro del modelo de servidor ASP.NET AJAX. Se trata
de un control web que no tiene ningin aspecto visual; sin embargo, realiza
la tarea clave de conectar los controles de servidor AJAX con las bibliotecas
JavaScript.
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Para agregar el ScriptManager en una pagina, lo podemos encontrar en el Tool-
box en el apartado Ajax Extensions (figura 99). Una vez arrastrado y soltado en
el editor, obtendremos el siguiente codigo (figura 100):

Figura 100. Cédigo .aspx de un ScriptManager

| Client Objects & Events -] (Mo Events)
<% Page Language="C#" AutoEventilireup="true" CodeBehind="NuevolebForm.aspx.cs”
Inherits="Nuevadplicacidniieb.NuevokebForm™ ¥»

<IDOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN"
“http: /v w3 org/ TR xhtml1/DTD/xhtmll-transitional .dtd">

s ¢html xmlns="http://www.w3.org/1999/ xhtml"™>
-i<head runat="server”>
<titler<ftitlex
</head>
<body>
- <form id="forml™ runat="server">
<asp:ScriptManager ID="ScriptManagerl” runat="server"»
<fasp:ScriptManagers
<div>
2|
<fdivy
£fform>
</body>
£/ html>

W% - 4 m

Cada pagina que utiliza controles ASP.NET AJAX requiere de una instancia y
solo una de ScriptManager.

5.2. Renderizaciones parciales con UpdatePanel

Sin duda alguna, el control AJAX mas importante de todos es el UpdatePanel.
Este control nos permite hacer renderizaciones parciales de nuestra pagina,
es decir, podemos refrescar partes de nuestra pagina sin tener que recargar la
pagina entera. El escenario habitual de un UpdatePanel es el siguiente:

e El usuario lanza un evento, como el clic de un botén dentro de un Upda-
tePanel.

e ASP.NET AJAX intercepta el evento y realiza la peticién asincrona de la
pagina al servidor.

e En el servidor se procesa la pagina de forma normal y se devuelve al na-
vegador.

¢ FEl navegador recibe la pagina y el codigo JavaScript se encarga de refrescar
solo el UpdatePanel donde se encontraba el boton.

Toolbox

» Standard

> Data

> Validation

> Navigation

> Login

> WebParts

4 AJAX Extensions
Pointer
ScriptManager
ScriptManagerProxy
Timer

UpdatePanel

hyaedu

UpdateProgress
> Dynamic Data

> Reporting

> HTML

4 General

There are no usable controls in this group.
Drag an item onto this text to add it to the

toolbox.

Figura 99. Caja de herramientas
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El UpdatePanel trabaja en conjunto con el control ScriptManager y, por lo
tanto, cuando utilizamos UpdatePanel debe haber antes un ScriptManager.
Por lo que para realizar un ejemplo, primero insertamos un ScriptManager
en nuestra pagina. A continuacién, en el mismo apartado Ajax Extensions del
Toolbox encontraremos el UpdatePanel. Al insertarlo en nuestra pagina, se
generara el siguiente codigo (figura 101):

Figura 101. Cédigo .aspx de un UpdatePanel

|  Client Objects & Events =] (Mo Events)
<% Page Language="C#" AutcEventWireup="true" CodeBehind="NuevokebForm.aspx.cs”
Inherits="Nuevatplicacidnkeb.NuevokebForm™ %>

<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN"
“http:/ fowe . w3, org/ TR xhtmll/DTD/ xhtmll-transitional . dtd”>

Sl <html »mlns="http://wew.w3.org/1999/ xhtml ">
-l<head runat="server®>
ctitler<ftitle>
</head>
| <body»
= <form id="forml™ rumat="server">
<asp:ScriptManager ID="ScriptManagerl” runat="server”»
</asp:SeriptManagers
<div>
<asp:UpdatePanel ID="UpdatePanell” runat="server">
</asp:UpdatePanel>
£fdive
</form>
</body>
</htmly

Wo% - 4 m

A continuacién, insertamos una Label dentro del UpdatePanel para ir mos-
trando el resultado de la llamada asincrona y un Button para ir lanzando di-

cha llamada.
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Figura 102. Cédigo .aspx de un UpdatePanel

| Client Objects & Events -] (Mo Events)
< head>
5:<budy>
El <form id="forml® runat="server">»
<asp:ScriptManager ID="ScriptManagerl” runat="server">
<fasp:ScriptManager>

B <divs
= €asp:UpdatePanel ID="UpdatePanell” runat="server" UpdateMode="Conditional®:
= <ContentTemplate>
<asp:Label ID="Labell” runats"serwver” Texts"Label"s</asp:Label»
<asp:Button runat="server” Text="Buttom" />
1! </ContentTemplate>
| & </asp:Updatepranz1j]
<fdiv»
| < fform>
| «/body>
< html >
W% = +

Realizamos el mismo proceso para agregar dos UpdatePanel més con un Label
y un Button cada uno.

Figura 103. Cédigo .aspx de un UpdatePanel

| Cient Objects & Events -] (NoEvents)
.<fhead>
=lgbody>
E <form id="forml" runat="server":
<aspiscriptManager ID="ScriptManagerl” runat="server">
<fasp:5criptHanager>

=] <div>
E= casp:UpdatePanel ID="UpdatePanell” runat="server” UpdateModes"Conditional®»
=] <ContentTemplates>
<asp:Label ID="Labell™ runat="server" Text="Label"></asp:Label>
<asp:Button runat="server” Text="Button" />
</ContentTemplate>
| </asp:UpdatePanel>
= <asp:UpdatePanel ID="UpdatePanel2” runat="serwver" UpdateModes"Conditional®»

=] <ContentTemplate>
<asp:Label ID="Label2" runat="server" Text="Label":</asp:Label>
<asp:Button runat="server” Text="Button" />
<fContentTemplate>
<fasp:UpdatePanel>
=] <asp:UpdatePanel ID="UpdatePanel3” runat="server" UpdateMode="Conditional™>
=] <ContentTemplate>
<asp:lLabel ID="Label3" runat="server" Text="Label"></asp:Label>
<asp:Button runat="server” Text="Button" />
</ContentTemplate>
</asp:UpdatePanel>
<fdiv>
| < /form>
| <fPody®
1W00% = <

En el archivo .cs de la pagina escribimos el siguiente c6digo para actualizar
cada uno de los Labels:
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Figura 104. Cédigo .cs de un UpdatePanel

MHueveWebForm.aspees X JI§ lebForm.aspx

4 MuevalplicacionWeb.NuevoWebForm ~| ¥ Page_Lc

lusing System;

-namespace NuevafplicacidnWeb

= public partial class NuevolWebForm @ System.Web.UI.Page
{

= protected void Page Load{object sender, Eventdrgs e)
Labell.Text = DateTime,MNow.ToString();

Label2.Text = DateTime.MNow.ToString();
Label3.Text = DateTime.MNow.ToString();

wWhae - 4

Si ejecutamos la pagina veremos como para cada clic de cualquier Button solo
se refresca el UpdatePanel donde estd contenido, aunque hayamos variado los
tres Labels.

Figura 105. Ejecucién del ejemplo de UpdatePanel

, L PRI 08 . - o] ]
(\3@ @ http://localhost6976/NuevoWebForm.aspx el 5'¢ fod

& localhost x
x 88| Eocbugtar S| @] @ ~| £ ~[ 257|105 -] @7 ) v B Buscoren Googe || Destacar enia pigna -
f v B v @ v Pagev Safety~ Toos~ @~ 35 N N ) i}
07/11/2011 15:17:33

07/11/2011 15:17:27
07/11/2011 15:17:31

®100% ~

5.3. Indicacion de estado con UpdateProgress

Mientras un navegador renueva una pagina, muestra al usuario algan tipo de
indicacién, por ejemplo un icono animado o un cambio progresivo de color
en la barra de direcciones, que permite saber que se encuentra ocupado, es-
perando recibir respuesta del servidor. Por defecto, las aplicaciones AJAX no
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cuentan con ese tipo de comunicacién de retorno, que resulta importante, ya
que sin ella la persona que utiliza el navegador no sabe si la comunicacion esta
en curso o es que la aplicacion sencillamente ha dejado de funcionar.

Introducir una indicacién de estado en una aplicacion ASP.NET AJAX resulta
muy sencillo, ya que existe un componente llamado UpdateProgress, que se
encarga de colocar en la pagina el elemento de notificacién que se desee. Esa
notificacién, ademaés, puede mantenerse oculta hasta el momento en que el
tiempo de espera supere un cierto limite, y vuelve a desaparecer automatica-
mente en cuanto la respuesta haya llegado. Las dos propiedades clave de este
componente son AssociatedUpdatePanelIDy DisplayAfter. Con la pri-
mera, el UpdateProgress se asocia con un UpdatePanel de la pagina, mientras
que la segunda establece el namero de milisegundos de espera tras los que se

hara visible la indicacién.

Al igual que otros componentes, UpdateProgress es un contenedor inicialmen-
te vacio. Para que realice su trabajo, es necesario introducir en el mismo algin

contenido: una etiqueta de texto, un pequefio grafico, etc.

Partiendo del ejemplo del subapartado anterior, afiadiremos en el interior del
primer UpdatePanel un UpdateProgress y dentro de este, una simple etiqueta

de texto con un mensaje.

Figura 106. Cédigo .aspx de un UpdateProgress

- (Mo Events;

<IDOCTYPE html PUBLIC =-//W3C//DTD XHTML 1.8 Transitional//EN"
“http: f e, w3 org! TR xhtmll /DTD/ xkhtsll -transitionsl . dtd™>
—<html sxmlns="http:/ /v .wd.orfg 1000/ xhtml "
- <head runats"server”:
stitlex</titles
& head >
<bodys
ifgrm id="forml" runat="server":
casp:Scriptianager ID="ScriptManagerl” renat="server™>
<faspiSoriptManagers
div»
<aspilpdatePanel ID="UpdatePanell® runat="server™s
<ContentTesplate:
<aspilabel ID="Labell™ runats”server” J»
Button ID="Buttonl” runate”server” Texta"Button™ onclicks®Buttonl Click™/»
p:UpdateProgress ID="UpdsteProgressl™ runats"server™>
<ProgressTemplate>
<asp:label ID="Labell” runat="server” Text="Cargandg..."/»
</ProgressTemplater
<fasp:UpdateProgress>
</ContentTesplate:
</aspiUpdatePanel>
fdive
</fora>
</fbody>
£ html
% =

Si ejecutamos el proyecto, no advertiremos en principio ninguna diferencia, ya
que el UpdateProgress esta programado para mostrar el mensaje si la respuesta
tarda mas de medio segundo en llegar. En un entorno real podria darse el caso
de que la peticién tardara més de medio segundo, pero probando en local, la

respuesta es casi inmediata.
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Para simular ese tiempo de espera escribiremos el siguiente codigo que retarda
el hilo de ejecucion:

Figura 107. Cédigo .cs de un UpdateProgress

MusvaWebFormuaspecs 0 ISR TE

1§ NuevatplicacidnWeb. NuevoWebForm | 4% Buttonl

using System;

- namespace MuesvasplicacidnWeb

public partial class

{

protected void Page Load(object sender, e 35 &)

{
¥

protected veoid Buttonl Click(object sender, Hh- &)
T
L

Labell . Text = Mo TaString( ) ;

System. Threading. 1d Sleepl1580) ;

%
I

% - 4

Ahora, al ejecutar de nuevo la aplicacion, se podra apreciar perfectamente el
funcionamiento del componente UpdateProgress.

5.4. ASP.NET AJAX Control Toolkit

Los controles UpdatePanel y UpdateProgress son bastante ttiles. Sin embargo,

son los tnicos controles AJAX que se encuentran en ASP.NET. Para ampliar

la gama de controles AJAX, Microsoft y la comunidad ASP.NET desarrollaron

ASP.NET AJAX Control ToolKkit.

ASP.NET AJAX Control Toolkit estd formado por decenas de controles que uti-

lizan las bibliotecas JavaScript de ASP.NET AJAX para crear efectos sofisticados.

Dos factores que ASP.NET AJAX Control Toolkit tiene a su favor son:

e Es completamente gratuito.

e Se incluye el cédigo fuente completo, gracias a lo cual el programador
podré personalizar los controles que lo componen.

5.4.1. Instalando ASP.NET AJAX Control ToolKit

Para descargar ASP.NET AJAX Control Toolkit, iremos a la direccién Ajax Con-
trol ToolKkit.



http://ajaxcontroltoolkit.codeplex.com/
http://ajaxcontroltoolkit.codeplex.com/
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Una vez hayamos descargador el archivo . zip Gnicamente descomprimimos
el archivo AjaxControlToolkit.d11l. Para conseguir integrar ASPNET AJAX
Control Toolkit con nuestro sitio web, debemos seguir una serie de pasos:

1) Primero es necesario crear un apartado nuevo en nuestro Toolbox pulsando
con el botén derecho sobre el mismo y seleccionando Add Tab (figura 108). Al
nuevo apartado lo llamamos “Control Toolkit”.

Figura 108. Afadiendo seccién para Control Toolkit

Toolbox A X
i> Standard
> Data
> Validation
> Navigation
> Login
> WebParts
> AJAX Extensions
> Dynamic Data
> Reporting
> HTML
4 General

Therear| [ Paste Ctrl+V jto this text to add it to the toolbox.
v | List View
Show All
Choose Items...
Sort Items Alphabetically

Reset Toolbox

Add Tab
Delete Tab
Rename Tab
Move Up
Move Down
Toolbox A X

i> Standard

b Data

b Validation

> Navigation

> Login

> WebParts

> AJAX Extensions

> Dynamic Data

> Reporting

» HTML

4 Control Toolkit
There are no usable controls in this group. Drag an item onto this text to add it to the toolbox.
4 General

There are no usable controls in this group. Drag an item onto this text to add it to the toolbox.
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En este momento tenemos un nuevo apartado en el Toolbox, pero no
contiene ningdn control. Para afladir los controles pulsamos con el bo-
ton derecho sobre Control Toolkit y seleccionamos Choose items (figura 109).
A continuacién, exploramos en nuestro sistema y escogemos el archivo
AjaxControlToolkit.dll que anteriormente extrajimos.

Figura 109. Afiadiendo seccién para Control Toolkit

Toolbox vyOXx
i Standard
> Data
> Validation
> Navigation
b Login
> WebParts
> AJAX Extensions
> Dynamic Data
> Reporting
> HTML
4 Control Toolkit

There are - 7 to this text to add it to the toolbox.
iy Paste Ctrl+V
4 General v List View
Show All
There are o this text to add it to the toolbox.
Choose Items...

Sort Items Alphabetically
Reset Toolbox

Add Tab

Delete Tab

Rename Tab

Move Up

Move Down

Automaticamente, se crearan todos los controles en nuestro nuevo apartado
Control Toolkit (figura 110).
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Figura 110. Afadiendo seccién para Control Toolkit

Toolbox vyAXx
4 Control Toolkit v
Pointer
HoverMenuExtender

ValidatorCalloutExtender
PagingBulletedListExtender
NoBot

Twitter
PopupControlExtender

m

AnimationExtender
Gravatar
CalendarExtender
AsyncFileUpload —
MutuallyExclusiveCheckBoxExtender

HtmlEditorExtender

DragPanelExtender

Accordion

SliderExtender

ModalPopupExtender

ToolkitScriptManager

RoundedCornersExtender
ListSearchExtender

ComboBox

LIOHE s MM BEEE» (€ il

P, T N

2) El biblioteca
AjaxControlToolkit.dll a nuestro sitio web. Pulsamos con el bo-

segundo  paso  importante es afiadir la
ton derecho sobre la carpeta References y seleccionamos Add Reference.
A continuacién, exploramos en nuestro sistema y escogemos el archivo

AjaxControlToolkit.dll (figura 111).

Figura 111. Afladiendo referencia a Control Toolkit

Solution Explorer ¥ 8 X | §Solution Explorer vyox
BloElw 2=
-a Solution ‘NuevaAplicacionWeb' (1 project) ; Solution 'NuevaAplicacionWeb' (1 project) -
4 A NuevaAplicacionWeb 4 A NuevaAplicacionWeb
[=d] Properties > [=d| Properties
\«a References. 4 [:3] References

4 [3] NuevoWe

2] NuevoWe Add Reference... <3 AjaxControlToolkit
Add Service Reference... 3 Microsoft.CSharp
Ej Nuevg Add Library Package Reference... +3 System ) )
%] Nuevc 3 System.Configuration
> |3 Web.conf Add Moles Assembly for mscorlib -3 System.Core

3 System.Data
+3 System.Data.DataSetExtensions
+3 System.Drawing
+3 System.EnterpriseServices
3 System.Web
3 System.Web.ApplicationServices
3 System.Web.DynamicData
3 System.Web.Entity
+3 System.Web.Extensions
3 System.Web.Services
3 System.Xml
<3 System.Xml.Linq
=] NuevoWebForm.aspx

a8 NueuaWehl lcerCantral acey.

m

Una vez afiadida la biblioteca de los controles debemos registrarla en cada

WebForm o UserControl que queramos con la directiva Register.

<%@ Register Assembly = "AjaxControlToolkit" Namespace

"AjaxControlToolkit" TagPrefix
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A partir de ahora podremos utilizar cualquier control de ASP.NET AJAX Con-
trol Toolkit mediante la etiqueta <asp: NombreControl></asp: Nombre-

Control>.

La biblioteca ASP.NET AJAX Control Toolkit, como ya hemos dicho, dispone
de multitud de controles. El objetivo del médulo no se trata de un analisis
exhaustivo de todos los controles, sino de ver unos ejemplos béasicos lo mas
genéricos posible. En los dos subapartados siguientes trataremos dos controles
de ejemplo para ver como utilizarlos: Accordion y AutoCompleteExtender.

5.4.2. Accordion

Un control Accordion es un contenedor en forma de pila con varios paneles
donde se puede ver solo uno cada vez. Cada panel tiene una cabecera y un
contenido. Cuando se hace clic en la cabecera de uno de ellos, el panel se ex-

pande y se muestra el contenido a la vez que los demas paneles se minimizan.

Para realizar un pequerio ejemplo con el control Accordion crearemos un nue-

vo WebForm, al que le afiadiremos la directiva:

<%Q@ Register Assembly = "AjaxControlToolkit" Namespace = "AjaxControlToolkit"

TagPrefix = "asp" %>

Como cualquier otro control AJAX, los controles de la biblioteca ASPNET
AJAX Control Toolkit necesitan de la presencia de un control ScriptManager.

A continuacion arrastraremos el control Accordion del Toolbox, con lo que se
creara el codigo siguiente (figura 112):
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Figura 112. Cédigo .aspx de un Accordion

<IDOCTYPE himl PUBLIC =-//W3C//DTD XHTHL 1.8 Transitionalf//EN"
“http: /o w3, org TR/ xhtell /07D shtmll-transitional . dtd™>

=l<html xomlns="http: !/ wew.w3.org/1999 xhtml" »
=l<head runats"server™>
ctitlese/titles
| «/head>
=l <body>
- <form id="forml"™ runat="server”>
<asp:5criptManager ID="ScriptManagerl” runat="serwver"s
</asprScriptManagers

<diva
= <asp:Accordion I0="Accordionl™ runat="server™»

<faspraccordions
<fdiv>
| </ forms
| </ bady >
</html>

W% - <
3 Design | O Split |§l Source ] E“-:html:||chxiy>”(fofm3fnrmlz-”(diln-| <asprdccordion®Accordion] »

Seguidamente afiadiremos el siguiente coédigo para construir nuestro Accor-
dion (figura 113):

Figura 113. Cédigo .aspx de un Accordion

| Client Objects & Events -
= <body >
I= §form fde"forml® runat="server®:
<asp:ScriptManager ID="ScriptManagerl™ runats"server™>»
<fasp:ScriptManager>

= divy
<asprAccordion ID="Accordionl” runat="server”:
LPanEs>
- caspiAccordionPane ID="AccordlonPanel® runat="server®:
- tHeaders
Header 1
< /Header»
= <Cantents
Pane 1
<fContent
<fasprAccordionPane
- caspiAccordienPane ID="AccordionFane2” runate="server®:
- cHeaders
Header 2
< /Header>
= <Cantents
Pane 2
<fContent
o fasprAccordlonPane»
</ Panes>
<faspiiccordions
<fdive
i </ farm®
0% - ¢

Vemos como cada seccion de nuestro Accordion se corresponderd con un Ac-
cordionPane y cada AccordionPane contiene un Header (que serad lo que
se muestre como cabecera) y un Content (que serd lo que se muestre cuando
el panel se expanda).
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Si ejecutamos nuestra web podremos comprobar el funcionamiento del Accor-
dion (figura 114).

Figura 114. Ejecucién del ejemplo del Accordion

. L | AP T

(\g@ @ http://localhost6976/NuevoWebForm.aspx

& localhost x — — , 90
x 88| Eoebugtar &~ Q| @ ~| £ ~[iv[00x -] @ B - D8 : M[C : -
f v B - = @ v Pagev Sofety~ Toosv @~ 33 N M )

Header 1

Pane 1
Header 2

l ®100% ~

5.4.3. AutoCompleteExtender

El ejemplo anterior del Accordion muestra un control totalmente nuevo que
tiene caracteristicas AJAX. En la biblioteca ASP.NET AJAX, Control Toolkit no
es el caso mas comun, ya que lo mas normal son controles que se complemen-
tan con los ya existentes en ASP.NET para afladirles funcionalidades AJAX.

Una de estas extensiones de control es el AutoCompleteExtender, que se com-
plementa con controles como el TextBox, y nos va ofreciendo una lista de po-
sibles valores mientras el usuario introduce caracteres. Si el usuario hace clic
en uno de los elementos de la lista, el valor se copia dentro del cuadro de texto.

Para ver la funcionalidad del AutoCompleteExtender crearemos un pequerio

ejemplo. Primero insertaremos un TextBox en un nuevo WebForm.
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Figura 115. Cédigo .aspx de un AutoCompleteExtender

HuevoWebForm.asps 2 [

CHent Objects & Events
X8 Page Language="C#™ AutoEventiireups"true”™ (odeBehind="HuevodebForm.aspx.cs”
Inherits="Nuevalppieb.HusvorebFore™ ¥

(Mo Even

CIDOCTYPE html PUBLIC "~/ /WEC//OTD XHTML 1.8 Transitional//EM"
"hittp: }'f‘ﬂ.w! org/ TFI_u"xhtml 10T/ /xhtell-transitional .dtd™»

<hitml wmlns="http:/ v . wd. org 1999, <html >
< chead runat="server®s
stitler</ritler
< head>
= cbady>
<form ide"forml™ runat="server®»
<diwv>
<asp: Textlox ID="TextBowl" runat="server™»< asp:Textlox>
< Sdivs
< Forma
<fbody>
£ html >

00% - 4
3 Design | O Split | = Source

A continuacién, y como en todos los controles AJAX insertaremos un Script-
Manager que controlaré la parte JavaScript del control. En este momento ya
estamos en condiciones de agregar el control AutoCompleteExtender a con-
tinuacién de nuestro TextBox. Unicamente debemos configurar tres propieda-
des del control:

e TargetControllID: identificador del control sobre el que se aplicara la

extension.

e MinimumPrefixLength: a partir de que el usuario escriba x caracteres, se
mostrara la lista.

® ServiceMethod: método que se encargara de devolver los items que se
mostraran en la lista
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Figura 116. Cédigo .aspx de un AutoCompleteExtender

HueveWebFormasps 2 |8

CHent Objects & Events | o Events)
X8 Page Language="C#" AutofventWireup="true” Codefehind="NuevckebForm.aspx.cs™
Inheritss="Nucvafppiel. NucvokebForm™ X»

<X8 Register Assesbly="AjaxContrelToclkit™ Nomespace="AjaxControlToolkit™ TagPrefix="asp" ¥

<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN®
“hitp: e w3 org TR xhtml 1 FDTDS whimll-transiticnal  dtd™»

S<html wmlns="http: /v w3 org 1599 xtml ">
=l <head runat="serverss
ctitlercfeitles
</head>
Hl<bady >
= cform ide“forml® runat="server®:
<asp:SeriptManager I0="ScriptManagerl” runats®ierver™>
</asp:ScriptManager:
= <div>
<asp:TextBox ID="TextBoxl" rumat=~server™><{/asp:TextBoox:
{aspréutoCompleteExtender I0="AutoCompleteExtenderl™ TargetControlIbs"TextBoxi"”
MinimumPrefixlengtha™2" ServiceMethods™Getlista™ runats"server™»
</asp:éutofompleteExtenders
« divs
< Forms
<bady>
< fhtnl>

W% - m
L4 Design | 2 Spiit ._l Source |i[tlnml:-”cbodys-ll-clnm#nnﬂl:-”edh» <aspeAutolomplateExtender.. >

El método que devolverd la lista de strings que se mostrara debe tener las ano-
taciones de WebMethod y ScriptMethod para que sea accesible directamente
desde Javascript.

Figura 117. Cédigo .cs de un AutoCompleteExtender

NusvoWebForm.aspics X

I Musvapp Wb MuevoWebForm =| N Ge

Snasespace Huevaspplieb

- public partial class NuevolebForm @ Systes,web, UL, Page

{

public static List<string> listaTotal = Aew Listcstrings();
= protected void Page Load(cbject sender, Eventirgs &)

listaTotal.Addrangs(new ~teing[]{"abe™,"abed™, "abede”, "aber™, “abedt™});
H

[System.Web.Services.WebMethod]
[System.wWeb.5cript.Services. Scriptiethod]
= public static List<string» GetLista(string prefixText, int count)

{
.i:f{string:n listaResultante = new ::int-::tring:{};
forepch (string item in listaTotal)
if (item.StartsWith{prefixText))
listaResultante, Add{iten);
}
}
return listaResultante;
}
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Vemos como tenemos una lista con todos los string “listaTotal” y inicamente
debemos comprobar en la funcién GetLista si cada elemento de dicha lista
empieza por la cadena entrada por el usuario.

Si ejecutamos la aplicacién web veremos como a medida que el usuario inserta
caracteres la lista se va actualizando.

Figura 118. Ejecucion del ejemplo del AutoCompleteExtender

A=

@ nttp://localhost:4178/NuevoWebForm.aspx

& localhost
X 8~ | (Bl DebugBar @&~ | | @& v| Z ~| 2iv| 100 ~| &~
- v [ d® v Pagev Safetyv Toolsv @~ 35 N [

®100% ~
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